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INTRODUCTION

Scopus Video Networks Ltd. takes great pride in delivery of its products and
makes every endeavor to ensure its clients full satisfaction.

On behalf of the whole Scopus team, we would like to extend our congratulations

on your investment in the SI1-3050 PSI/SI Generator.

ABOUT THIS MANUAL

The Scopus SI-3050 User Manual provides information and instructions for using
the Scopus SI1-3050 PSI/SI Generator. This manual is comprised of the following

chapters:
Chapter 1
Chapter 2
Chapter 3
Chapter 4
Chapter 5

Chapter 6

Overview

Installation

PS1/SI Management Window
Bouquets Management Window
Event Management (EPG) Window

Scheduler Management

INTENDED AUDIENCE

It is assumed throughout this manual that personnel have general knowledge
about the Scopus system concept and architecture, Scopus building blocks as
well as the Scopus S1-3050 application and capabilities.

SCOPUS DOCUMENTS (P/N 100793) (REV. 2.1/ SW V2.1/Decmber 2008) Page 8
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WARRANTY

SCOPUS Video Networks Ltd. warrants that the product and any part thereof, including but
not limited to spare parts will, when properly installed, conform to SCOPUS Video Networks
Ltd. published specifications. Also, the product and any parts thereof, including but not limited
to spare parts, will be free from defects deriving from faulty workmanship and faulty materials
under standard use and service, for a period of twelve (12) months following the date of
manufacture thereof.

The supply of spare parts at a reasonable cost shall be available for a period of three (3) years
from the date of delivery.

This warranty does not cover ordinary wear and tear of the product or other defects due to
circumstances beyond SCOPUS Video Networks Ltd. control, such as: unsuitable operating
means, chemicals, electro-mechanical issues, or electrical influences and damages, which may
be caused by interference by the CUSTOMER or any unauthorized third party.

Defective cards and assemblies will be sent to SCOPUS Video Networks Ltd. for repair. The
repaired cards and assemblies will be returned to the CUSTOMER within 30 days from their
receipt by SCOPUS Video Networks Ltd.

Cards and assemblies repaired during the twelve (12) month warranty period will carry a
warranty of six (6) months from date of repair or until the end of original warranty period,
whichever is the later date.

SCOPUS Video Networks Ltd. sole liability under this warranty shall be limited to the repair or
replacement with equivalent units at SCOPUS Video Networks Ltd. facilities, of any product or
parts thereof that do not conform to SCOPUS Video Networks Ltd. published specifications or
that are defective in material or workmanship, as specified above. The expense of installing
repaired or replaced parts shall be borne by the CUSTOMER.

SCOPUS Video Networks Ltd. sole obligation under this warranty is to be the supplier of the
product to the CUSTOMER and to provide such services as set out in this warranty according
to the SCOPUS Video Networks Ltd. terms and conditions provided for herein. In no event will
SCOPUS Video Networks Ltd. be liable to the CUSTOMER for any: business expenses, loss of
profits, or incidental, indirect, or consequential damages, however caused, unless such
expenses, loss, or damages shall have derived from an infringement of patents of copyrights.

THE WARRANTIES STATED HEREIN ARE EXCLUSIVE AND ARE EXPRESSLY IN LIEU OF ALL
OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

Beyond the warranty period, SCOPUS Video Networks Ltd. shall repair or replace defective
cards and assemblies according to its standard and relevant price list at such time. Cards and
assemblies thus repaired shall carry a warranty of six (6) months.

TECHNICAL SUPPORT

In case of technical problems with the system or one of its components, refer to additional
System Documentation. Usually, this may save time in resolving technical difficulties.

If you are not able to resolve the problem, call your local distributor for technical support.

SCOPUS DOCUMENTS (P/N 100793) (REV. 2.1/ SW V2.1/Decmber 2008) Page 9
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Chapter 1.
OVERVIEW

1.1. TECHNOLOGICAL EDGE

The Scopus SI-3050 PSI/SI Generator is a modular, scalable and configurable,
yet powerful and user-friendly distributed application, which provides the user
the following capabilities:

e Generation of static and dynamic DVB Service Information (SI) and MPEG-2
Program Specific Information (PSI) tables.

e Generation of Electronic Program Guides (EPGSs).

e Injection of the PSI/SI table streams into stream multiplexers (such as the
Scopus IVG-7000/8000 Series of Intelligent Video Gateways) in broadcast
head-end systems.

e Execution of scheduled tasks at predefined times.
e Import of data from different formats (Including XML and Excel formats).

e Handling the entire PSI/SI information in an intuitive, system-oriented
manner, without having to deal with table details where it is not needed.

The PSI/SI Generator provides management for the following:

e Network Stream and Service Management; manages the network
components parameters: networks, streams, services and PIDs.
¢ Events Management; manages the services events parameters. Each service

has its own event management window.

e Bouquets Management; manages the network bouquets parameters. Each
network has its own bouquet management window.

SCOPUS DOCUMENTS (P/N 100793) (REV. 2.1/ SW V2.1/Decmber 2008) Page 10
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1.2. HIGHLIGHTS AND BENEFITS

The SI-3050 PSI/SI Generator is a powerful, yet easy to use Windows 2000 / XP
software application for generation, editing and insertion of PSI/SI tables. The
following is a summary of the key features of the SI1-3050:

MPEG-2 PS/
Tables Generation

DVB SI Tables
Generation

PS1/SI Descriptors

The following MPEG-2 Program Specific Information (PSI)
tables are generated by the PSI/SI Generator:

e PAT — Program Association Table
e PMT — Program Map Table
e CAT — Conditional Access Table

The following DVB Service Information (SI) tables are
generated by the PSI/SI Generator:

e NIT — Network Information Table
e SDT — Service Description Table

e EIT — Event Information Table (both Present/Following
and Schedule)

e BAT — Bouquet Association Table
e TDT — Time and Date Table
e TOT — Time Offset Table.

The PSI/SI Generator generates flexible, future-proof
design, using standard and private (generic) descriptors.
The generator enables insertion of descriptors in
compliance with the following:

e ETSI EN-300 468, for DVB Sl descriptors.

. ISO/IEC 13818-1, for MPEG-2 PSI descriptors.

SCOPUS DOCUMENTS (P/N 100793) (REV. 2.1/ SW V2.1/Decmber 2008) Page 11



User Manual
S1-3050 PSI1/S1 GENERATOR

$lscopus

EPG Generation

Central Database
and Information
Consistency

Interfaces

The Electronic Program Guides (EPGs) generated by the

application has the following capabilities:

User Friendly Graphic User Interface (GUI) for building
an up-to-date overview of present and future
broadcast services.

Set parental lock based on different age groups.
Personalization of viewing by using filtering of favorite
channels and event categories.

Supports multi-language (Unicode or other character
tables) descriptors.

The PSI/SI Generator generates a central database with

the following capabilities:

All information is stored in relational (SQL) database.
Provides local or remote database management.

Provides optional support for multi-terminal
(distributed) configuration.

Allows backup/restore of data stored in the database.

10/100 BaseT interface for streaming tables over
UDP/IP, Unicast or Multicast.

ASI interface for table generation into any multiplexer.

SCOPUS DOCUMENTS (P/N 100793) (REV. 2.1/ SW V2.1/Decmber 2008) Page 12
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1.3. APPLICATIONS

The PSI/SI Generator can be used in a wide range of applications, such as:

Fixed Distribution / Contribution
Satellite, DVB-T, MMDS

Cable TV Head Ends

Digital Turnaround

Direct To Home (DTH)

1.3.1. PSI/SI Generator Integration in
DVB Application

Figure 1-1 illustrates the PSI/SI Generator in a typical video distribution system.
The entire network, stream, service and event information is stored in a central
database. This information is generated, configured, maintained and monitored
by the PSI/SI Generator.

Figure 1-1: Typical DVB Environment Application

SCOPUS DOCUMENTS (P/N 100793) (REV. 2.1/ SW V2.1/Decmber 2008) Page 13
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1.3.2. Standard PSI/SI Application

Figure 1-2 shows a PSI/SI Generator. The database and the Data Carousel are
on the same server computer. They work independently until the PSI/SI
Generator instructs the Data Carousel to get the tables from the database and
continue sending them independently.

The PSI/SI Generator User Interface is on the server as well.

Server

PSI-SI
User Interface  yanage patabase

& pPsi =]

]

Database

I,
I

[
! Manual Updates
on "Send Tables"

(AN

Command or

v automatic update. |
Carousel .

SC (0] p us IVG < PSI-S| Tables throguh ASI or Ethernet @ b

Figure 1-2: PSI/SI Generator — Standard Application

1.3.3. Distributed PSI/SI Application

Figure 1-3 shows three PSI/SI Generator GUIs on three different remote client
computers. The server computer is connected to all the client computers and
holds the common single PSI/SI database. The server is also connected to two
computers with Data Carousels. One Data Carousel is redundant. Each Data
Carousel sends PSI/SI tables to two Multiplexers.

The Matrix maps the two working Multiplexers to be broadcast in the Uplink. In
case of a failure in one of the two Multiplexers or Data Carousel 1, the matrix can
be rerouted to the redundant Multiplexers and Data Carousel 2.

Each of the three PSI/SI Generator GUIs can manage the PSI/SI database.
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Figure 1-3: PSI/SI Generator — Distributed Application
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1.4.

1.4.1.

1.4.2.

FUNCTIONAL DESCRIPTION

The SI1-3050 PSI/SI Generator is based on a distributed architecture functionally
divided into three components:

e The Database Server component, explained in paragraph 1.4.1
e The Data Carousel component, explained in paragraph 1.4.2

e The PSI/SI Generator graphical user interface (client), explained in
paragraph 1.4.3

The PSI/SI Generator main purpose is to generate PSI/SI tables. Paragraph 1.5
defines the PSI/SI tables.

PS1/SI1 Database

The PSI/SI Generator keeps its information on a relational (SQL) database. The
PSI/SI database contains all the table parameters and descriptors generated.

The PSI/SI database is updated and managed by the PSI/SI User Interface. The
user is asked to specify a PSI/SI Database name and location before starting to
work on the PSI/SI Generator. This feature enables the user to manage several
PSI/SI databases on different sites.

The PSI/SI Client can work with one database at a time. The database is located
on a PSI/SI server computer and can be controlled by any remote client
computer.

Data Carousel

The Data Carousel is a computer program that organizes and sends the
information from the database to the Multiplexer. The Data Carousel is running
as service application. The Data Carousel displays a ‘chip’ icon on the system
tray in the bottom of the screen. Double clicking the ‘chip’ icon displays the Data
Carousel main screen. The main screen shows errors should they occur and
allows to select a database containing the data to be generated.

The Data Carousel sends its data through UDP (over an IP network) or through
an ASI output. The Data Carousel obtains it’'s own copy of the PSI/SI database
information at start up, or when the user chooses the “Send Tables” command
from the PSI/SI Generator.

SCOPUS DOCUMENTS (P/N 100793) (REV. 2.1/ SW V2.1/Decmber 2008) Page 16
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EIT Present / Following data is also refreshed when an event has stopped or
started. EIT Schedule data is also refreshed every midnight.

The Data Carousel is installed on a computer that is connected to the Multiplexer.
Several Data Carousels can be installed for large networks on different
computers. Every Data Carousel can be controlled separately to send specific
streams to different Multiplexers by providing the Multiplexer IP address to the
PSI/SI Generator.

One Data Carousel can send PSI/SI information of a number of streams
simultaneously. For each stream, it is possible to configure more then one target
(multiplexers). This enables a variety of system configurations.

PSI1/SI Generator Remote Client

The PSI/SI Generator Client manages the PSI/SI database, builds it, and controls
the Data Carousels. It provides an easy to use interface for scheduling events
and adding different descriptors to the PSI/SI tables.

Changes made with the PSI/SI Generator Client are saved immediately on the
database. However, the changes take affect only when the Send Tables
command is executed.

The PSI/SI Generator Client can be located on any client computer connected to
the PSI/SI database server computer over an IP network or on the server itself.
Several PSI/SI Generator Clients can simultaneously manage the same PSI/SI
database from different client computers.
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1.5. PSI/SI TABLES

The PSI/SI Generator can automatically generate the tables based on the PSI/SI
database information. The IVG-7000/8000 Series, or another multiplexer, can
also automatically generate a basic form of most of those tables. Every method
of creation has its advantages. Generating the tables can be shared between the
Multiplexer and the PSI/SI Generator as long as two table types are not created
twice.

Creating tables with the PSI/SI Generator obligates the user to synchronize
mutual parameters in the PSI/SI Generator to match those on the Multiplexer.

The following sections provide explanation on the various PSI/SI tables; MPEG-2
Program Specific Information tables (MPEG-2 PSI tables, see details in 1.5.1) and
DVB Service Information tables (DVB Sl tables, see details in 1.5.2).

1.5.1. MPEG-2 PSI Tables Description

1.5.1.1. Program Association Table (PAT)

The Program Association Table (PAT) is like a root directory for the transport
stream. The PAT lists all the programs in the stream and provides the PID
(Packet ldentifier) value for the Program Map Table (PMT) associated with each
program. The PAT can also contain the PID number for the Network Information
Table (NIT), which provides access to other transport streams in the network.
The decoder is always able to find the PAT (if present in the stream) since it is
always in packets with a PID value of 00.

1.5.1.2. Program Map Table (PMT)

The Program Map Table (PMT) provides a description for each program in a
transport stream. This table literally acts as the map for a program, listing the
PID values for its video, audio, clock reference and data components. With this
information, the decoder can locate the audio and video for the program and
display them synchronously.
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1.5.1.3. Conditional Access Table (CAT)

The Conditional Access Table (CAT) provides a mechanism for decoders to find
Entitlement Management Messages (EMMs) in the transport stream. EMMs
update the subscription options or pay-per-view rights for each subscriber or for
groups of subscribers. The CAT lists the EMMs in the transport stream and gives
the associated PID values.

1.5.2. DVB — Sl Tables Description

1.5.2.1. Time and Date Table (TDT)

This table provides the present UTC date and time, which can be adjusted
according to time zone and presented on screen for the viewer.

1.5.2.2. Timing Offset Table (TOT)

This table contains the UTC time and date, along with the local time offset.

NOTE

It is possible for the TDT and TOT to synchronize the PC time with any reference
PC using NTP (network time protocol) client and NTP server.

1.5.2.3. Network Information Table (NIT)

The Network Information Table (NIT) provides information regarding the
transmission system, as well as other transport streams in the network.

A Network is a system of one or more transport streams controlled by a single
content provider. The Network Information Table (NIT) contains information
regarding the physical organization of the transport streams carried on a single
network, including the tuning parameters that enable the receiver to change
channels at the viewer’'s command with little or no delay. Tuning parameters are
specific to the type of transmission assigned to the network - terrestrial, cable or
satellite. This table also includes characteristics about the network itself. There
are two types of NIT:

e “NIT actual” is the NIT table of the network containing the current stream

e “NIT other” are the NIT tables of the other networks in this profile (not
including the network containing the current stream)
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1.5.2.4. Service Description Table (SDT)

A Service is a sequence of programs under the control of a broadcaster, which
can be broadcast as part of a schedule. The Service Description Table (SDT)
provides information about the services available in the network, including the
name of the service provider and the textual description of the channel. There
are two types of SDT:

e “SDT actual” is the SDT table of the current stream

e “SDT other” are the SDT tables of the other streams in the network
containing the current stream (not including the current stream itself)

1.5.2.5. Bouquet Association Table (BAT)

A Bouquet is a commercial offering, or a group of services that can be purchased
as a single product. The Bouquet Association Table (BAT) describes the services
available in a given bouquet.

1.5.2.6. Event Information Table (EIT)

An event is a collection of elementary streams with a common time base set to
start and end at the same time. (We often refer to events as “TV programs”.)
The Event Information Table (EIT) provides information about events in the
network, such as their start time and duration. Two different types of EITs can be
transmitted at the same time: EIT Present and Following and the EIT Schedule.
The EIT Present-following describes the event currently being broadcast and the
next event to be broadcast on that service. The EIT Schedule lists events
available on the network for anywhere from the next few hours to the next few
days, depending on the service provider’s implementation. There are two types
of EIT:

e “EIT actual” are the EIT tables of the services in the current stream

e “EIT other” are the EIT tables of the services in other streams in the
network containing the current stream (not including the services in the
current stream)
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1.6. PLATFORM SPECIFICATIONS

The following are the hardware and software specifications for the PSI/SI
Generator workstation:

e IBM x3250 1RU Dual-Core Pentium Server
e 4GB RAM

e 10/100Base T UDP Interface

e ASI Interface

e Microsoft® Windows XP/2000™
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Chapter 2.
INSTALLATION

The installation program of the PSI/SI Generator is built out of several easy and
intuitive dialogs. Follow the steps below to install the PSI/SI Generator: (Unless
already installed in the factory)

#8 PS1/SI Generator ¥2.0 x| H

e This oo 1scpea sherging ¥ Fingiorel Optoni™ 1. Remove older versions of the PSI/SI
sﬁal'm; Follow these instructions and then re-instal the PSI1/SI Generator software if installed on
ereator,
On'Windows XP you need: the computer.

gmtwldewc?meﬂwwLangmeplm.

n the "Advanced" tab. "Code page conversion table” section,

sm”;?éssaﬁ cm??sc ?Iagm: 1 2. Shut dowtr: the co;ngu;er alnd .
20269 (1 28591 (150 88531 West European), 28592

(IS0 88592 E ast European), 28593 (150 88533 South connect the supplied dongle to the
Eutopean), 28594 (IS0 82594 Noth and Norlh E ast E urcpean), LPT port of the computer.

28595 (1S0 9959-5 Cynilic), 29596 (1SO 8959-6 Arabic), 28597
(150 89597 Greek), 28598 (IS0 8959-8 Hebrew), 28533 (1SO

8533 Latin 5], 874 (150 885911 Thai, 332 [ANSI/OEM 3. Turn on the computer.
Japanese Shift-JIS). 350 (ANSI/OEM - Traditional Chinese Big5)
Press the "OK" bulton 4. Run the installation program. Wait
for the welcome dialog.
5. Click the [Next] button to display
the Destination Location dialog.
X _
s . 5. Choose a directory for the
Destination Location ) .
o installation.
L " It is recommended to use the

: ; : default directory.
Setup willinstall PS1/S| Generator V2.0 in the following folder.

Toiinstallinto a different folder, cick Browse, and select another folder. 6. Click the [Next] button to display
You can choose notta install PSI/51 Generator V2.0 by chcking Cancel to exit Setup. the Select Components dialog.
- Destination Folder

C:A\Program Files\Scopus\PSI-S| Generator Browse... I
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| 75151 eneratorvzo X
Select Components o
N
In the options list [ PS1/5| Genesator Server 24573k
below, selectthe |7 PSS! Generator Cien 328K
aptions that you ¥ PSI/5] Generator Carousel 24397k
would like to have
installed.
The disk space fields
reflect the
requirements of the
ophions you have
selected
Dizk Space Required: 34605 k.
| Disk Space Remaining: 21600230 k
ok [Ho> ] _corce |
8 Psu/sicenenatorv20 x|
Start Installation

S

N

‘You ate now ready to install PS1/S| Generstor V20
Press the Next button to begin the installation or the Back bulton to reenter the installation

ok |
ﬂ.g Setup - Firebird Database Server 1.5 A

Welcome to the Firebird Database
Server 1.5 Setup Wizard

=gl

This will install Fuebird 1.5 0 4306 on your computer.
It iz recommended that you close all other applications before
S

Click Mext lo continue, or Cancel to exit Setup.

Mext >

7.

10.

11.

12.

13.

Select which components will be
installed. For full installation, make
sure all three components are
selected.

Click the [Next] button to display
the Start Installation dialog.

Click the [Next] button on the
Start Installation dialog to start
copying and installing the PSI/SI
Generator files.

Click the [Next] button. This will
open the Firebird installation
program.

Click the [Next] button to display
the License Agreement dialog.

Read the license agreement and
click the [Yes] button to display
the Information dialog.

Click the [Next] button on the
Information dialog to display the
Select Destination Directory
dialog.
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|l§|v Setup - Firebird Database Server 1.5

Select Destination Directory

14. Choose a directory for the

Where should Firebird D atabase Server 1.5 be installed? installation.
It is recommended to use the
Select the folder where you would ke Firsbird Database Server 1.5 ta be installed, then default direCtOfy.

click Next.

ichFirebird 1 5 15. Click the [Next] button to display
D C\ - the Select Components dialog.
) Acro Software
) Adobe
) Ahead

) Apple Software Lpdate
(=) Commaon Files

. =
Iievc: j

The program requires at least 1.4 ME of disk space.

< Back I Mext » I Cancel |
||°ﬁ Setup - Firebird Database Server 1.5

Select Components
Which components should be installed?

16. On the Select Components dialog,
select from the drop down list the
‘Full installation of server and

Select the companents you want to instal; clear the companents you do not want to development tOOIS’ Option and CIle

install Click Next when you are ready to continue. the [NeXt] button to dlSplay the

Select Start Menu Folder dialog.

© Super Server binary 1.5MB

O Classic Server binary 1.3MB H

B] Sorver compororte T 17. Click the [Next] button on the

[¥] Developer and admin tools components 42 MB Select start menu folder dlalog to
& Client comporents 1.3 MB

display the Select Additional
Tasks dialog.

Current selection requires at least 8.8 ME of disk space.

< Back I Mext » I Cancel |
]TE‘ Setup - Firebird Database Server 1.5 ] o ] JE |

Select Additional Tasks
‘which additional tasks should be performed?

18. Make sure the following options on
the Select additional tasks dialog
will be selected:

Select the additional tasks you wauld ke Setup to perform while instaling Firebird e Create a Menu Group

Database Server 1.5, then click Next. .

¢ Install IBServer using the
guardian service

¥ Use the Guardian to control the server?

Run Firebird server as: B . )

£ Run as an Application? e Start Firebird service when setup

# Run as a Service? complete

G e e ) 19. Click the [Next] button to display

I | Cors Febad chent Mxan o ¢ epetems tecton the Ready to Install dialog.

¥ Generate client ibrary as GDS32.DLL for legacy app. support? R

% Install Control Pan Applet? 20. Click the [_Install] _button on the
Ready to install dialog to start

< Back Newt > Cancel | copying and installing the Firebird

server.

SCOPUS DOCUMENTS (P/N 100793) (REV. 2.1/ SW V2.1/Decmber 2008) Page 24



U M |
ser Manua QJSC_OPUS
SI1-3050 PSI1/S1 GENERATOR Videoll Networks

#§ PSI/SI Generator ¥2.0 i ﬂ

21. Click the [Finish] button on the
P51/51 Eenerstorv2: 1 has beor sucosssfil nstaled PSI1/SI Generator final screen. After
a few moments, the Install dialog

Press the Finish button to exit this installation. B
Displays.

22. The Installation program must
restart the computer to complete
the installation. Click [OK] on the
Install dialog to complete the
installation and restart the
computer.

< Back IE Eﬁ > i Caricel I
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Chapter 3.
PS1/S1 MANAGEMENT WINDOW

3.1.

GENERAL

The PSI/SI Management window is the PSI/SI Generator main window and it
manages network, streams, services and PID related parameters. The PSI/SI
Generator displays the PSI/SI Management window after connecting to the
PSI1/SI database.

Figure 3-1 shows the PSI/SI Management window.

The window consists of the following main sections:

a. Menu Bar — provides management commands. See paragraph 3.2.

b. Tool Bar — provide database connectivity commands. See paragraph 3.3.

c. Main Display View - The Left side of the window shows a hierarchical
view of the PSI/SI Management Tree. See paragraph 3.4.

d. Detailed Display View - The right side of the window shows the details
of the selected item on the PSI/SI Management Tree. See paragraph 3.5.

Main Display

View

Detailed
Display View

4 "'hi": -;‘#r"l.."lﬂ | -ﬁ-ﬁg-“-!- ;\; ?ﬁtﬁ;iu .

P Bl 10 Wedao)

rharg

-
- *
+ -
» +
E M
-
L £
1 Srwan Tyew *
o | B Chaocas iom et M
2 [T [l SOAEC 6182 Viekes PFEGZ = (i
: H
= M
1 Sicsil |
- -
+ ORI e T H
- Widen Glream ezt +
- L
- J *
H Gl | wPEn 2| .
: Fuwna Flas M
3 B Chooos hom et *
- Gatfl [t 2297% =1l
-
H Fiags H
b | I~ Mg Frams i E
3 R :
e | I Comminsrasd Pasmsie I
l I Gl Pass H
-+ -
- H
* :
H -
a -
E M
-

=T I - [iel [
R N T T T T T T T T T L et “.1.-“..“.41111'[.-;1111]*
Cowwrmabend tn b Prop e Fleed Sttt 5151 Dot wion'E g il

Figure 3-1: PSI/SI Generator PSI/SI Management Window
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3.2. MENU BAR

This section describes the PSI/SI management Menu bar. Paragraph 3.2.1
describes the structure of the menu bar and a brief description on each
command. The following paragraphs explain some of the commands and dialog
boxes in more details.

3.2.1. Menu Bar Structure

The main menu bar of the network display is displayed in Figure 3-2 and is
summarized in Table 3-1.

Main Menu
[
[ [ [ | [ | |
Database Edit Carousels Tools Additionals Window Help
\ | | | \ | |
Connect New [ltem] Send Profiles Bouquets Cascade PSISI S;l;eration
\ | | | \ | |
Disconnect Change [ltem] ID Send to All Scheduler Configure Tile Horizontaly About
\ | | | [ |
New Delete [Item] Receive Log Events Tile Vertically
| | |
Backup Cut [ltem] Rates Content Minimize All
|
Restore Copy [Item] Arrange All
\ | |
Exit Paste [ltem)] Close
Figure 3-2: PSI/SI Management Window Menu Bar
Table 3-1: Network Display Menu Bar
Item DESCRIPTION
Database=>Connect... Opens the ‘Connect to Database’ dialog. Refer to paragraph 3.2.2 for
more details.
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Table 3-1: Network Display Menu Bar

Item

DESCRIPTION

Database=>Disconnect

Disconnects from current database. This command closes all open
windows in the PSI-SI Generator. Refer to paragraph 3.2.3 for more
details.

Database 2New...

Opens the ‘Create New Database’ dialog. Refer to paragraph 3.2.4 for
more details.

Database>Backup...

Opens the Backup dialog. The Backup dialog let the user make
backups of the database. Refer to paragraph 3.2.5 for more details.

Database>Restore...

Opens the Restore dialog. The Restore dialog let the user restore a
previously saved backup. Refer to paragraph 3.2.6 for more details.

Database2Exit

The Exit command closes the PSI/SI Generator user interface.

NOTE

The Data Carousel will continue to work properly after the PSI/SI
Generator user interface is closed

Edit>New [Item]

Create a new item in the PSI/SI Management Tree. for details see
section 3.4.1

The [Item] type is depended on the currently selected object.

Edit=>Change [Item] 1D

Changes the selected item's ID. For details see section 3.4.3. The
[Item] type is depended on the currently selected object.

Edit>Delete [Item]

Deletes an item from the PSI/SI Management Tree. Refer to
paragraph 3.4.4 for more details. The [Item] type is depended on
the currently selected object.

Edit>Cut

Cuts a PSI/SI Management Tree item from the Main Display view.
The Cut command is used for moving PSI/SI Management Tree
items to different places (using the Paste command). The Cut
command works only on networks, streams, services, or PIDs.

SCOPUS DOCUMENTS (P/N 100793) (REV. 2.1/ SW V2.1/Decmber 2008) Page 28




User Manual

S1-3050 PSI1/S1 GENERATOR

$lscopus

Table 3-1: Network Display Menu Bar

Item DESCRIPTION

Edit=>Copy Copies a PSI/SI Management Tree item from the Main Display view.
The Copy command is used for copying PSI/SI Management Tree
items to different places (using the Paste command). The Copy
command works only on networks, streams, services, or PIDs.

Edit>Paste Pastes a PSI/SI Management Tree item under a selected item in the
PSI1/SI Management Tree.

Edit=>[Item] Enabled Enable or disable an item. Refer to paragraph 3.4.8 for more details.
The [Item] type is depended on the currently selected object.

Edit>Import XXX The PSI/SI Generator has the ability to import events from external
files. Refer to paragraph 3.4.9 for more details.

Carousel>Send... Opens the ‘Send Tables’ dialog. Refer to paragraph 3.2.7 for more
details.

Carousel/=>Send to All Sends the tables to all data carousels currently connected to the
active database. Each Data Carousel uses its last profile.

Carousel=>Receive... The Receive command receives a video transport stream and builds
the PSI/SI Generator Database according to the video stream PSI/SI
Tables. Refer to paragraph 3.2.8 for more details.

Carousel2>Rates... Opens the ‘PSI/SI Tables Rate Measurement’ dialog. Refer to
paragraph 3.2.9 for more details.

Tools>Profiles... Opens the Profiles dialog. Refer to paragraph 3.2.10 for more details.

Tools>Scheduler... Opens the Scheduler dialog. Refer to Chapter 6 for more details.

Tools>Log... Displays the system event Log. Refer to paragraph 3.2.11 for more
details.

Additional>Bouquets Opens the Bouquets Management Window. Refer to Chapter 1 for

more details.
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Table 3-1: Network Display Menu Bar

Item DESCRIPTION

Additional>Configure Opens the Stream Configuration dialog. Refer to paragraph 3.2.12 for
more details.

Additional >Events Opens the Event Management Window. Refer to Chapter 5 for more
details.

Additional=>Content Opens the PID Contents dialog. Refer to paragraph 3.2.13 for more
details.

Window>Cascade Cascades all the opened windows

Window>Tile Horizontally

Tiles Horizontally all the opened windows.

Window >Tile Vertically

Tiles Vertically all the opened windows.

Window>Minimize All Minimizes all the opened windows.

Windows>Arrange All Arranges all minimized windows.

Window>Close Closes the selected window.

Window>Window List The ‘Windows list’ lists on the menu all the opened windows.

Selecting a window from the list moves the focus to the selected
window.

Help>PS1/SI Generator Help

Opens the Program on-line help file.

Help2>About

Displays the About dialog.
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3.2.2. Connect to Database

Before starting to use the PSI/SI Generator, a database must be created or
connected to. The ‘Connect to Database’ dialog defines an existing database to
be used with the PSI/SI Generator.

The ‘Connect to Database’ dialog can be opened by choosing File=>Connect...
from the PSI/SI management menu bar. By default, the PSI/SI opens the last
used profile when connected. When the last used profile is unknown, the PSI/SI
opens the Profiles dialog. Refer to paragraph 3.2.10 for more detail regarding the
profiles dialog.

Figure 3-3 shows the ‘Connect to Database’ dialog. Table 3-2 explains the
‘Connect to Database’ dialog components.

& Connect to Database x|

[atabase Information

" Remote Server

Server IP ar Mame | j

Databaze |E:"\P'r|:|gram Filezh5 EI

Matifier Info
Motifier Port 4050 =]
|zer Information
|zer Mame |5YSDB.-’-‘-. j
Passord |“

J 0k x Cancel |

Figure 3-3: Connect to Database Dialog

NOTE

The ‘Connect...” command is disabled after a database connection has been
achieved. To connect to a different database — close the current connection and
then reconnect to a new database.
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Table 3-2: Connect to Database Dialog parameters
ITEM DESCRIPTION
Local Server / Chooses between a database on this computer, or
Remote Server on a remote server.
Server IP or Name Selects the server IP address or the server name,

only if “Remote Server” is selected.

Database Changes the database name and directory.

Notification Server Port Selects the Notification server port. This
parameter is set during installation and should not
be changed.

User Name Changes the user name. This parameter is set

during installation and should not be changed.

Password Changes the password. This parameter is set
during installation and should not be changed.

3.2.3. Disconnect from Database

Choosing the ‘Disconnect from Database’ command will close all active windows
on the PSI/SI Generator and will disconnect from the current database.

After disconnecting from a database, the user can reconnect to another database
or create a new database.
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3.2.4. Create New Database

The ‘New...” command from the PSI/SI management menu bar opens the ‘Create
New Database’ dialog.

The ‘Create New Database’ dialog is identical to the ‘Connect to Database’ dialog.
See Figure 3-4. The ‘Create New Database’ dialog creates a new database and
connects to it. The PSI/SI Generator must be connected to a database before
starting to operate.

= Create New Database x|
i~ Database Information

(+ 1 ocal Serves " Remote Server

Server IP or Mame I j

Database IC: “Program Files\S EI

~ Notifies Info
Notifier Port {4050 |
r— Uzer Information
UserName  |SYSDBA |
P d quum‘mcm:
' OK X Cancel |

Figure 3-4: Create New Database Dialog
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3.2.5. Backup Database Dialog

A special backup feature is provided to make a backup of the database. The
Backup Database dialog saves a backup file of the database on the location
specified in the Filename parameter. The Backup Database dialog is shown in
Figure 3-5.

™ Backup Database x|

— Databaze Infarmation

(% LLocal Senver " Bemaote Semver

Serven B ar Mame I j

[Matabaze IE:HPngram Filezh5 EI

— Backup Information
Filenarne || EI

o OK X Cancel |

Figure 3-5: Backup Database Dialog

On a local database, the backup file can be saved anywhere using the browse
icon next to the Filename parameter. When the database is remote on the
server, the backup must be saved in the server computer. The browse icon is not
displayed when the database is remote.
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3.2.6. Restore Dialog

The Restore Database dialog restores a previously backed-up file. The restored
database is not automatically connected to the PSI/SI Generator. To connect the
database, the user should disconnect from the currently opened database and
then reconnect to the restored database.

Figure 3-6 shows the Restore Database dialog.

™ Restore Database x|

— Databaze Infarmation

@ LocalServer Remate Server

Server IP or Mame I j

Databaze I EI
— Uszer Infarmaticn

Izer Mame ISYSDE-'*'- j

Passward Ixxxxxxxxx

— Backup Infarmation
Filenarne I EI

o OK X Cancel |

Figure 3-6: Restore Database Dialog

The Restore Database dialog contains the following parameters:

a. Local Server / Remote Server — the location of the database after
restoration.

b. Server IP or Name combo box — the server name or IP address. This
parameter is valid only when the database is on a remote server.

c. Database edit box - The database name and directory.

d. User Information — the user name and password. Those parameters
should not be changed.

e. Filename — the backup file to restore.
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3.2.7. Send Tables Dialog

The ‘Send Tables’ dialog manages the Carousels data dispatch.

The ‘Send Tables’ dialog is opened by choosing Carousels>Send... from the
PS1/SI Management window menu bar.

Figure 3-8 shows the ‘Send Tables’ dialog.

® Send Tables x|
Data Carouzel Profile | |

glave Crefault

— "When zending tables
¥ Refrezh anly tables that were changed since last send [recommended)

£ Fully refresh all tables [takes longer time)

85 cerl | < Retiesh | [HE

Figure 3-7: Send Tables Dialog

The ‘Send Tables’ dialog has a Data Carousels list. The Data Carousel list
contains all Data Carousels that are connected to the same database file. Each
Data Carousel is assigned a profile. Refer to paragraph 3.2.10 for more detail
regarding profiles.

The Send Tables dialog has the following operations:
a. Modify a Data Carousel

1. Double click on the profile name. A selection box with all available
profiles is opened.

2. Choose a profile from the list.
b. Send tables to Data Carousels

1. Select the Data Carousels from the list by clicking on them. Several
Data Carousels may be selected.

2. Select whether all the tables are refreshed or only the updated tables
are refreshed when the [Send] button is pressed.

3. Press the [Send] button. The updated profiles have been sent to the
selected Data Carousels.
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NOTE

The process of sending tables of large data bases might take a few minutes to
execute, however it runs in the background without interfering the carousels or
GUI operation.

c. Refresh the Data Carousel display

Press the [Refresh] button. The Data Carousel list is updated.
d. Close the dialog

Press the [Close] button. The Sent Tables dialog is closed.

NOTE

The Data Carousels2Send to All menu command sends the data to all
connected Data Carousels.

3.2.8. Receive Tables Dialog

The Receive Tables dialog enables the user to receive tables from a video
transport stream from a specific Data Carousel. The Data Carousel builds PSI/SI
Generator database profile according to the PSI/SI tables found in the video
stream.

The ‘Receive Tables’ dialog is opened by choosing Carousels>Receive... from
the PSI/SI Management window menu bar. Figure 3-8 shows the Receive Tables
dialog.
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i+ File File E xtension hp

— Advanced Settings
[ Eeep“ersion Murnber

[~ Keep Section Mumbers
[~ Keep Descriptor Table

[+ Maotify me when analyzing is finished

%;1, Beceive | E Cloze |

Figure 3-8: Receive Tables Dialog

The Receive Tables dialog has the following parameters:

a. Data Carousel — Select a Data Carousel to handle the process of
receiving the tables from the transport stream

b. Interface — Select the interface of the transport stream:
1. None — default setting. Do not receive any transport stream.

2. File — Receive a transport stream from a file. A directory and a file
extension parameter are needed

c. Advanced Settings — The Advanced Settings is for advanced users and
for advanced purposes only!

d. Notification Setting — notify the user when the process is complete. The
process time may be very lengthy.

The received PSI/SI tables are kept in a new profile. The new profile is created
automatically by the PSI/SI Generator program.
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3.2.9. PSI1/SI Tables Rate
Measurements Dialog

The ‘PSI/SI Tables Rate measurements’ dialog may be opened by choosing
Carousels2>Rates... from the PSI/SI Management window menu bar.

Figure 3-9 shows the ‘PSI/SI Tables Rate measurements’ dialog.

4 Rate Measurements x|

Carousel |_Sheam |_Rate [Bps] |_Estimated [Bps] |
GED1 UDP (Address = 1.1.1.1:1234) 18837 18827

< Befesh | [ R Ciose ||

Figure 3-9: PSI/SI Tables Rate Measurements Dialog

The ‘PSI/SI Tables Rate Measurements’ dialog displays a list showing the
following parameters:

a. Carousel — the data carousel name. The table shows all the available
data carousels connected to the selected database.

Stream — shows all the streams in every data carousel.
Rate [Bps] — shows the actual stream rate in Bps units.

d. Estimated [Bps] — shows an estimated rate of the stream in Bps units.
The estimated rate is calculated by the information stored in the database
and should be close to the actual rate.

The ‘PSI/SI Tables Rate Measurements’ dialog has the following two buttons:

a. [Refresh] button — Refreshes the information presented in the table.

b. [Close] button — closes the dialog.
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3.2.10. Profiles Dialog

The PSI/SI Generator may control more then one set of DVB elements. The
PSI1/SI tables are built using the DVB elements. Each set of DVB elements is
managed in its own profile and in a separate PS1/SI Management window. All
profiles are saved under the same database. Each Data Carousel can send one
profile at a time. Figure 3-10 shows the Profiles dialog.

&g Profiles - D% Program Files', Scopus',PSI-SI Generator ﬂ
Prafile M ame =
Default L=~ Open
Prl:lfllez ...................................
> Delete
@ Bename

Figure 3-10:  Profiles Dialog

The Profiles dialog has a list of all the profile names. The Profiles has the
following buttons:

a. [Open] button — opens the PSI1/S1 Management window that contains
the selected profile.

b. [New] button — makes a new empty profile. A new profile has an empty
DVB PSI/SI Management Tree.

c. [Delete] button — deletes the selected profile from the profile list.

s CAUTION

ALL DVB NETWORK RELATED DATA WOULD BE LOST AFTER DELETION!

d. [Rename] button — rename the profile name.
e. [Close] button — closes the Profiles dialog.
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3.2.11. Log Dialog

The Data Carousels Log may be opened by choosing Tools>Log... from the
PS1/SI Management window menu bar.

Figure 3-11 shows the Carousels log.

X
Time of Event Event Source Source Type Event Description |
i)(01/08/2002 165307 slave D ata Carouzel Creation of PS1/5] tables completed.
i)(1/08/2003 16:53.07 slave D ata Carousel Creation of P51/5! tables from profile "Default” started.
i) (01/08/2003 16:53.07 slave D ata Carousel Caonnected o server.
i)01/08/2003 165302 slave Scheduler Connected bo server.
Expoart | ¥ Clear | e Refresh |

Figure 3-11:  Data Carousels Log

The log keeps a table of events with the following columns:
a. Time of Events — date and time of the event

b. Event Source — The computer name, where the event occurred. The
PSI1/SI Generator can have several Data Carousels on several different
computers.

c. Source Type — The event can be cause by a Data Carousel or by a
Scheduler task.

d. Event Description — describes the event. In case of a Scheduler task
error, the description includes the exact command that failed in the task.

The Log has the following four buttons in the bottom of the log:

a. [Export] button — Exports the log to an HTML format and saves it in the
“\Logs’ directory under the PSI/SI program directory.

[Clear] button — Clears the events in the log.
[Refresh] button — Refreshes the events display.
d. [Close] button — Closes the log window.
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3.2.12. Stream Configuration

The stream configuration dialog manages the table creation process of the
selected stream item from the PSI/SI Management Tree. The stream
configuration dialog supports multiple Multiplexers by optionally defining more
then one way of sending tables.

A CAUTION

TABLES CAN BE CREATED BY THE MULTIPLEXER OR WITH THE PSI/SI
GENERATOR. EACH OPTION HAS ITS ADVANTAGES.

IT IS IMPORTANT TO CHECK THAT NO TABLE WILL BE GENERATED TWICE! REFER
TO 6.3.3.5.ArPENDIX A FOR CONFIGURING TABLE GENERATION ON THE
MULTIPLEXER.

The PSI/SI features sending a table to multiple Multiplexers in several different
ways. The feature is implemented by a list of different stream configurations.
Each configuration defines the table generation differently. Pressing the [New]
button creates a new configuration in the list. Pressing the [Delete] button
deletes the selected configuration from the list.

The Data Carousel creates a copy of the tables for each configuration and sends
to the defined Multiplexer.

To access the Stream Configuration window, from the PSI/SI Management
window menu bar, go to: Additional>Configure.

Figure 3-12 shows the stream configuration dialog. Table 3-3 explains the
‘Stream Configuration’ dialog parameters.

NOTE

For information regarding the PSI-SI tables, refer to paragraph 1.5.
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Multiple

Configuration Interface Tab Tables Tab Carousels Tab  Misc. Tab

£ Stream Configuration 3

UDP [Address =1.1.1.1:1234

PID Mumbes |0x0000

Restore Default |

Repetition Time |350 [ms]
Restore Default |

W] MIT [actual)
L1 NIT [other)
¥ SDT [actual)
[1SDT [other)

] EIT [actual - p/f)
] EIT [actual - sch)
1 EIT [other - p/f)
] EIT [other - sch)
Vi BAT =l

Appl}ll Ha?ﬂashl
[ Hew ¥ Delete EQUS& |

Figure 3-12:  Stream Configuration Dialog

Table 3-3: Commands Descriptions
SECTION DESCRIPTION
Multiple Multiple configurations enable to send a stream to several Multiplexers in different
Configuration |ways. For example, a single Data Carousel may send a stream through ASI to

Multiplexer 1 and through UDP to Multiplexer 2.

Pressing the [New] button creates a new configuration in the list.
Pressing the [Delete] button deletes the selected configuration from the list.

Interface Tab

Selects between different output types:
e None — No tables will be created.

e UDP — uses the UDP output type.
Changes the address and the Port number of the Multiplexer.

e ASI — uses the ASI output type:
ASI card number — selects the ASI card number. When there is one ASI card
on the computer, its number is always zero. In case of more than one ASI
cards, define the card to use.
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Table 3-3:

Commands Descriptions

SECTION

DESCRIPTION

Interface Tab

e Send stuffing packet — when sending stuffing packets, the bit rate can be

(Contd) maintained constant. To enable constant bit rate, check the “Send Stuffing
Packets” and set the “Stuffing Packets PID”.
NoOTE
When using the 1IVG-7000/8000 multiplexers with the PSI/SI, the stuffing packet
PID should be Ox1FFE.

e File — Write tables to a file (Binary format).

Specifies a directory to save the files and an extension name for the files.

e Use stuffing to fill packets groups — Some devices requires receiving IP
packet with 7 MPEG packets. The feature allows adding stuffing MPEG packet
to transmitted IP packet.

Tables Tab A list of all the tables that can be created using the PSI/SI Generator.

Only checked tables on the list will be created.

Clicking on the check boxes toggles between check and uncheck.

The table repetition time manages the repetition time in milliseconds of the

currently selected table. The data carousel will wait the specified time between

transmissions of the selected table.
Carousels Manages the use of data carousels.

When the check box ‘Send tables by these data carousels only’ is checked —
The tables are created only by the data carousels found on the data carousels list.

When the check box ‘Send tables by these data carousels only’ is
unchecked - all the data carousels, which are configured to work with the profile
containing this stream, will create the tables. (Recommended for small systems)

Writing the data carousel IP or name in the edit box and pressing the [Add]
button will add the data carousel to the data carousel list.

Selecting a data carousel from the list and pressing the [Del] button will delete
the data carousel from the data carousel list.
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Table 3-3: Commands Descriptions
SECTION DESCRIPTION
Misc. Allows saving system resources by limiting the number of days ahead, when

updating content from the EIT.
The limit ranges from 4 to 64, increased by four.

To limit the EIT days, go to the Misc tab, mark the Limit EIT content checkbox,
and use the arrows to select the limit number of days head.

The stream configuration dialog has the following operations:

a. Modifying a configuration
Select a configuration from the configuration list and modify the parameters
using Table 3-3. Apply the changes using the [Apply] button.

b. Adding a different configuration

Press the [New] button. A new configuration named “None” appeared in the

configuration list. Modify the selected configuration. The configuration name

in the configuration list is changed only after the [Apply] button is pressed.
c. Deleting a configuration

Select a configuration and press the [Delete] button. The configuration is
deleted.
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3.2.13.

PID Contents Management

The PID contents management enables the user to specify the PID actual data.
Specifying the PID actual data should be done to data PIDs only.

Figure 3-14 shows the PID contents dialog.

NOTE

Use this option by advanced users only and for advanced purposes only.

[¥ Send Content General PID Content
: o |
zeneral R ion Time ir ( )
— Content Bytes =
Calculate CRC32
Lengh [e01t  PSI-SI Table Content

i PID Content x|

Content for FID Default-0001-0001-0001-0001

oo| 01] 02{ 03] 04 05] 06] 07] o8] 03] 0] o8] ocf ooy o€ oF |
0000 FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF
L1}

0 |FF FF FF FF FF FF FF FF FF FF FF FF FF FF FF

 topy | & Befiesh | 26 Close

Figure 3-13:  PID Contents Dialog

To edit a PID data, do the following:

1.

2
3.
4

@

Select the PID from the PSI/SI Management Tree.

Press the [Content] command on the Additional menu.

Check the [Send Content] check box.

Click on the General PID Content, or on other type of PID content, if
installed.

(The basic PSI/SI Generator package installs only the “General PID Content™)
Specify a repetition time in milliseconds units.

Change the parameters of the PID Content. In case of “General PID
Content”, these are the Length of the data, and the data itself in
hexadecimal.

Press the [Apply] button.
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3.3. TooL BAR

The PSI/SI Generator Tool bar is identical and common under all the different
displays on the program. All tool bar commands can be found under the File
menu commands.

The Tool bar has the following commands:

[H Connect to database. See paragraph 3.2.2 for details.

[E Disconnect from database. See paragraph 3.2.3 for details.

£

Create a new database. See paragraph 3.2.4 for details.

N
T

Backup Database. See paragraph 3.2.5 for details.

Restore Database. See paragraph 3.2.6 for details.

Create a new item to the PSI/SI Management tree. See paragraph 3.4.1
for details.

Change an item on the PSI/SI Management tree. See paragraph 3.4.3
for details.

Delete an item from the PSI/SI management tree. See paragraph 3.4.4
for details.

Cut the selected object. See paragraph 3.4.5 for details.

Copy the selected object. See paragraph 3.4.5 for details.

Paste the selected object. See paragraph 3.4.6 for details.

B |# [= |x [= O |8 |2
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Send tables to specific Data Carousels. See paragraph 3.2.7 for details.

i ) Send the tables to all Data Carousels currently connected to the active
database. Each Data Carousel uses its last profile.

'T.J'.;I Receive tables from transport stream. See paragraph 3.2.8 for details.
<1 Display Data Carousels rate information. See paragraph 3.2.9 for

details.

Manage PSI/SI profiles. See paragraph 3.2.10 for details.

Manage scheduling tasks. See chapter Chapter 6 for details.

Opens the Bouquet management window. See Chapter 4 for details.

EEE
@ Display the Log dialog. See paragraph 3.2.11 for details.
5\ Opens the Stream configuration window. See paragraph 3.2.12 for

details.

Opens the Event management window. See paragraph Chapter 5 for

|
i
-

@ [e

details.

Opens the PID Contents management window. See paragraph 3.2.13 for
details.
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3.4. MAIN DISPLAY VIEW

The main display view shows the hierarchical PSI/SI Management Tree. See
Figure 3-14.

Main Display

View

Network
Tree

w3 PSIfs. Generator - Epg.gdb - [Default] _I— _ID 1'
[\3 Databdse Edit DataCarousels Tools Afditional ‘window Help =& =l
SEALBE LEX e Damle BCH BXES
E1 D3 OvB . -
EQN work 10 01000 PID: Dx1111 {Video)
¢ @ Bream ID: 01100 PuT |
El-@ Service 1D: 01110 ShizEn e
% E:g g“} 1::; [B:d:o: Edit  Chaoose from list
- : O udio -
& Service I 01210 IDxDZ IUHUZ ISO/IEC 13818-2 Yideo [MPEGZ) J
i-ipq PID: 01 211 Videa)

L[ PID: 0x1212 [Data) — —
g Stream [D: 0x1200 EEl I Elres |
B4 Network 1D: 0x2000

Video Stream Descriptor

General | MPEG 2|
Iy | Frame Rate

Edit Choose from list
[0t [0t 23578 -
rFlags———————————

[~ Multiple Frame R ate

Tbll [~ MPEG 1 Only

[~ Constrained Parameter
[~ Stil Ficture

; = Del | Apply | Refresh

Connected to D:%Program Files\S copushPS1-5| Generator\Epg.gdb v

Figure 3-14:  PSI/SI Generator PSI/SI Management Window

The PSI/SI Management Tree on the Main display has the following levels:

a. DVB — the root of the tree. The root of the tree can have several
Networks attached to it.

Network — a network contains streams.
Stream — a stream contains services.

Service — a service gathers several PIDs to form a program.

© a0 o0

PID — a PID is a form of data that transmits on the stream. A PID can
represent a video source, an audio source or a data source.

The Main Display manages the hierarchy of the PSI/SI Management Tree.
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A new empty database contains only the DVB component on the PSI/SI
Management Tree. The DVB component is the root of all components in the
PSI/SI Management Tree.

Most items on the PSI/SI Management Tree have the following operations
regardless of the item type (Network / Stream / Service / PID):

e Exporting all tree information to XML 3.4.1.

Adding items. See paragraph 3.4.2.

Changing the item ID. See paragraph 3.4.3.

Removing the item. See paragraph 3.4.4.

Copying / Cutting / Pasting an item. See paragraph 3.4.5.
Drag and drop support. See paragraph 3.4.7.

Disabling the item. See paragraph 3.4.8.

Some items on the PSI/SI Management Tree have additional actions which can
be performed.

All the operations are selected from a context menu. The context menu has the
same basic operations on all of the item types. The operations in the context
menu are related to the selected item.

Figure 3-16 shows a context menu for the stream item on the PSI/SI
Management Tree.

N
[ Mew Service

|§ Change Stream ID
W Delete Stream

c',"o Cuk Stream
Copy Skream
& Paste Service

1 |T Stream Enabled

. Bouguets

‘5\ Configure
@ Events
@ Conkent

Figure 3-15:  Stream Item Context Menu
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3.4.1. Exporting All DVB Network
Information to XML

The Export command allows creating an XML-based file which includes the DVB
network structure information.To export the DVB network information to XML:

1. From the network tree, right click the DVB icon.
2. Select Export to XML DTX file.
3. Choose a destination path for the file, and click OK.

3.4.2. Adding Items to the PSI/SI
Management Tree

To add an item to the PSI/SI Management Tree, do the following:

1. Select an item from the PSI/SI Management Tree. The new item will be
created beneath the selected item in a lower level. For example: to create
a Service - select a stream that will contain the service.

2. Click the right mouse button on the item. A context menu is opened.

3. Choose the ‘New [Item Type]’ command from the context menu. A
dialog is opened. Figure 3-16 shows a ‘New Service’ dialog example. The
new item type is dependent on the selected item.

4. Enter the item ID in the dialog and click on the [OK] button. A new item
was created.

New Service x|

Enter new Service |0
Ranged 0=0000 - 0=FFFF

o

Enter Decimal nurmber
[e...] for Hes number

o OK X Cancel |

Figure 3-16:  New Service ID Dialog
NOTE

An ID number in any dialog can be written in decimal form or in hexadecimal
form with a Ox prefix in the start of the hexadecimal number.
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3.4.3. Changing Item ID on the PSI1/SI
Management Tree

To change an item ID number, do the following:

1.
2.

Change PID x|

Select an item from the PSI/SI Management Tree.
Click the right mouse button on the item. A context menu is opened.

Choose the ‘Change [Item Type] ID’ command from the context menu.
A dialog is opened. Figure 3-17 shows the ‘Change PID’ dialog example.

Change the item ID in the dialog and click on the [OK] button.
The item ID has changed.

Enter new PID
Ranged 0=0000 - 0=1FFF

01111

Enter Decimal nurmber
[e...] for Hes number

o OK X Cancel |

Figure 3-17:  Change PID Dialog

3.4.4. Removing Items from the
PS1/S1 Management Tree

To remove an item from the PSI/SI Management Tree, do the following:

1.

a kM wDn

Select an item from the PSI/SI Management Tree.

Click the right mouse button on the item. A context menu is opened.
Choose the ‘Delete [Item Type]’ command from the context menu.
Confirm the item deletion.

The item has been deleted.
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3.4.5. Copying / Cutting Items from
the PSI/S1 Management Tree

Items on the PSI/SI Management Tree can be moved and copied.

To Copy or Cut an item, do the following:

1. Select an item from the PSI/SI Management Tree.

2. Click the right mouse button on the item. A context menu is opened.
3. Choose the ‘Copy’ or the ‘Cut’ commands from the context menu.

3.4.6. Pasting Items on the PSI/SI
Management Tree

To paste an item, do the following:

1. Select a target item from the PSI/SI Management Tree. The buffered item
will be placed beneath the target item.
The target item must be one level higher then the buffered item, providing
that the target item is not the original parent of the buffered item.
For example: a service can be copied only beneath a stream, which is not the
current service parent.

2. Click the right mouse button on the item. A context menu is opened.

3. Choose the ‘Paste’ command. The buffered item appeared beneath the
target item.

3.4.7. Drag and drop support

Moving an item to a different place in the PSI/SI Management Tree is done by
dragging the item to a new place. Copying is done in the same manner with the
CTRL key pressed. Dragging with the Shift key pressed opens a context menu.
The context menu provides a selection between Moving, Copying and canceling
the operation.

SCOPUS DOCUMENTS (P/N 100793) (REV. 2.1/ SW V2.1/Decmber 2008) Page 53



User Manual f js
S1-3050 PSI1/S1 GENERATOR m«: ewms

3.4.8. Disabling Items

Disabled item parameters will not be generated on the PSI/SI tables but will
remain in the database. The item can be enabled again.

A disabled item is marked with Red icon as seen in Figure 3-18 on Service
0x1110, PID 0x1111 and stream 0x1300.

[%3 PSI/SI Generator - Epg.gdb - [Default]
[/} Database Edit Data Carousels Tools &ddition.

FE5 BREBIDEX & Br

= D/3 DVB
= Network ID: 0x1000
El kj Stream D: 0x1100
ek Q Service ID: 0x1110
@4 PID: 0x1111 [Video]
| L. PID: 041112 [Video)
_4& Service |D: Ox1120 )
-4 PID: 0x1121 Video) Disabled
: i PID: 0x1122 (video)
----- (& Stream ID: 0x1201

Figure 3-18:  Disabled Items in the PSI/SI Management Tree

A disabled item makes its lower lever items automatically disabled too although
the lower level items themselves are not marked as disabled.

For example: Service ID 0x1120 is disabled and so are his lower level items: PID
0x1121 and PID 0x1122. All the events inside this service are also disabled. The
disabled items will not appear in the bit stream.

To enable / disable an item, do the following:

1. Select an item from the PSI/SI Management Tree.

2. Click the right mouse button on the item. A context menu is opened.
3. Choose the ‘Enabled’ command from the context menu.

4. The item state has been toggled between enabled and disabled.
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3.4.9. Importing Events

The PSI/SI Generator has the ability to import events from external files in the
following formats:

Microsoft Excel Sheet — an Excel file containing events information.

EVT File — an XML file containing events information with an EVT extension.

Example files for all import formats exist in the “Import” directory beneath the
PS1/SI Generator installation directory.

To import events, do the following:
1. Select a service from the PSI/SI Management Tree.

2. Right click with the mouse on the selected service. A context menu
appeared.

3. Select the commands: "Import from Excel File..." or "Import from XML EVT
File..." from the context menu. A dialog is opened.

4. Select the appropriate data file from the dialog and click the [Open]
button.

NOTE

Importing from excel files format require the installation of excel version 9.0
(also known as Excel 2000) on the computer.
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3.5. DETAILED DIsSPLAY VIEW

The detailed display view shows the details of the selected item on the PSI/SI
Management Tree. See Figure 3-19.

Detailed

Descriptor Display View

List Section

L#3 PSI/SI Generator - Epg.gdb - [Default] - x|
[\3 Database Edit DataCarousels Tools Additional Window Hep -1 Item Name
P B, g [ O3 B Section
EEs RRAIDEX| ¢ B BR SRR RE. ]
= 03 DvB - : .
2@ Network 1D: 041000 H PID: 1111 (Vidza)
2@ SueanD: 04100 :FMT' .....................................................
4l Service ID: 0x1110 o | ——
e L LR o o
i PID: 031112 fRudio) 2
: 0402 [0:02 150IEC 13818-2 Video [MPEGZ) = i
= s Sevice ID: 041210 . | I~ PrOpertles
©-fpg FID: 01211 Video]  me, .
- PID: 01212 (Data) i spply | Refresh| Section
& Stream ID: 0x1200 -
@ Network ID: 02000 2 Video Stream Descriptor
: il
.
o General | MPEG 2|
: ﬂ e FE i
: Edit  Choose from list DeSC rl pto r
. 0401 [ 01 23,978 |
: === Management
= [~ Multiple Frame Rate H
.
s Tl | T MPEG 1 Oy SeCtlon
. [ Constrained Parameter
= [~ SHil Picturs
.
.
.
.
.
.
: [wd] =oa | o | |
Cannected ta [1\Program FileshScopushPSI-51 GeneratarEpg.odb 2

Figure 3-19:  PSI/SI Generator PSI/SI Management Window

The ‘Detailed Display’ is divided into four sections:
a. Item Name Section

Shows the selected item on the PSI/SI Management Tree. Refer to paragraph
3.5.1.

b. Properties Section

Manages the properties of the tables and descriptors. Refer to paragraph
3.5.2.

c. Descriptor List Section
Manages the selected item descriptor list. Refer to paragraph 3.5.4.

d. Descriptor Management Section

Manages a selected descriptor from the list. Refer to paragraph 3.5.5.
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NOTE

After changing any configuration, press the “Apply” button to accept the new
configuration or “Refresh” to decline the new configuration and retrieve the one
saved in the database. The new configuration will be lost unless the “Apply*
button was pressed.

Sending data to the Multiplexer only occurs when choosing ‘Send Tables’ from
the Data Carousel menu (refer to paragraph 3.2.1). Pressing the “Apply” button
only saves the information on the database.

3.5.1. Item Name Section

The Item Name section displays the item name as it appears on the PSI/SI
Management Tree. Refer to the item name section example on Figure 3-19. All
the sections below the Iltem Name section are related to the Item itself.

The name of a Network item is determined by the “Network Name Descriptor”.
The name of a Service item is determined by the “Service Descriptor”

3.5.2. Properties Section

The properties section manages the selected item data. Each item type has a
different properties section. Refer to the properties section example on Figure
3-19. The common controls in all the items are:

a. [Refresh] button — Restores the properties section parameters. Changes
made by the user, which were not applied, will be lost.

b. [Apply] button — Applies the changes made by the user.

The following paragraphs describe the different properties sections for the
streams, services and PIDs.
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3.5.2.1. Network Properties

The network properties section manages the NIT table.

Figure 3-20 shows the Network properties section

Network 1D: 0x1000

MIT

Lpply | Refresh |

Figure 3-20:  Network Properties section

3.5.2.2. Stream Properties
The stream properties section manages the PAT, CAT, NIT and SDT tables.
The NIT and SDT should usually be equal to the Network ID that contains them.
Figure 3-21 shows the stream properties section.
Stream ID: 0x1100

PAT |caT  NT |spT |

Original Metwork, 1D IDHDDDD

Apply | Fiefresh |

Figure 3-21:  Stream Properties section
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3.5.2.3. Service Properties
The service properties section manages the PAT, PMT, SDT and EIT tables.
Figure 3-23 shows the service properties section.

Service ID: 0x1130

PaT | PMT  SDT e

¥ EIT Schedule Running Status
¥ EIT Prezent/Following IDW1 rLnning j

[™ Free CA Mode

Aol | Refresh |

Figure 3-22:  Stream Properties section

Configuring the PAT PMT PID and the PMT PCR PID correctly is crucial in
establishing a correct transport stream. Refer to paragraph A.2 for coordinating
these values with the multiplexer.

3.5.2.4. PID Properties

The PID properties section manages the PMT Stream Type.

Figure 3-23 shows the PID properties section.

PID: Dx1131 (Video)

F'.I-IT|

Sitneaen T pps

Edt  DChooss fnom kst

@02 | [0:02 1ISOAEC 13918-2 Video MPEG2)
(el 1S208EC 138182 Wi

B2 ISOAEC 111723 Audio MPEGT)
Dl ISDAEC 138183 Audie [MPEGZ)
D405 ISOAEC 138181 peivishe smelions
4 (06 ISOAEC 133181 PES packeds contaming pervabe: data
007 1S0AEC 13522 MHEG

D08 ISOAEL 138181 DEM-CC

DS ISDAEC H 222 1 |

Figure 3-23:  PID Properties section

Changing the PMT stream type can be done by selecting a type from the list or
directly edit the type number in the edit box next to the list.
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3.5.3. Advanced Table Settings

Advanced Table Settings allow additional configuration of the table parameters,
for example: configuring which sections the table is built and a manually selected
table version. The highlighted section in Figure 3-24 shows the advanced
management of the PAT table of a stream.

PID: 0x0002 (Audio)

PMT |
. Manually Configure Section List  Enter section number
Create this —=— r
VTR S | Add |
table for |
this node - | Del |

Apply ] Refiesh ]

Figure 3-24:  Properties section — Advanced Management

To display the advanced management section of a table, do the following:
1. Choose a table from the table tab.

2. Click the right mouse button on the table parameters area and choose
from the pop up menu: View Advanced Settings. The advanced
configuration for this table appears. See the following figure:

Stream |1D: 0x0001

PAT |cat |niT | soT |

@3 Copy PAT Stream Information

Yiew Advanced Settings

3. The following parameters can be changed:

By default, the [V] sign next to the ‘Create this PSI/SI table for this
node’ is marked and the table is created. When the [V] sign is
unmarked, the table will not be created.

To add a section number:

Check the ‘Manually select table sections' parameter, enter a section
number on the 'Enter section number' edit box from the right and click
the [Add] button. The section number is inserted to the 'Section List'
list box.
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To delete a section number:
Select the section number from the section list and click the [Del]
button.

To manually define a version for the table, mark [V] next to ‘Manually
select version’ and write a version number on the edit box below.

NOTE

Always prefer the automatic selection of table sections.
The Table Generation Advanced management is for advanced users and for

advanced purposes only!

3.5.4. Descriptors List Section

The descriptor list section manages the descriptor list for the selected item.

Figure 3-25 shows the descriptor list section.

PMT Conditional A
PMT Registration D ptor

SOT NWVOD Reference Descriptor ﬁl
SOT Stuffing Descriptor

PT Private Data Specifier Descrip Ll

i

1 | B

‘Addl = el |

Figure 3-25:  Descriptor List Section

The Descriptors list section has the following buttons:
a. [Up] button — moves the selected descriptor one raw above.
b. [Dn] button — moves the selected descriptor one raw below.

c. [Tbl] button — switches between the PSI/SI tables. This button is enabled
only when the selected descriptor can appear on a different table for the
currently selected item.
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d. [Add] button — opens a list of descriptors available to the current item.
The selected descriptor will be added to the descriptor list. The descriptor
dialog is organized in a hierarchy order by the descriptors tables. Figure
3-26 shows an example of the Select Descriptor dialog for a stream
component.

- Conditional Access Descriptor
- Praprigtary Descriptar

[=]- MIT
- Service Ligt Descriptar

- Shuffing Descriphar

- Satelite Delivery System Descripkar
- Cable Delivery Syztern Descriptor

- Temestial Delivery Systern D escriptar
- Private D ata Specifier Descriptor

- Frequency List Descriptor

- Proprietary Descriptar

[=-T0OT

- Local Time Offset Descriptar

- Proprietary Descriptor

o K X Cancel |

Figure 3-26:  Select Descriptor Dialog

b. [Del] button — delete a selected descriptor from the descriptor list.
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3.5.5. Descriptors Management
Section

The descriptor management section manages the descriptor parameters. Each
descriptor has different parameters. Figure 3-27 shows the descriptor
management section.

Subtitling Descriptor N OTE

Lﬁwlfppe ]F‘agelDi

- The Advanced Settings View is for advanced
Language

Edt  Choose from list ' users and for advanced purposes only!
l_ | =l I - After changing any configuration, press the
Language | Subtiing Type _f” “Apply” button to accept the new configuration
| or “Refresh” to decline the new configuration
_|| and return the old one. The new configuration
will be lost unless the “Apply* button was
pressed.

K I _>|g

s Refissh when choosing ‘Send Tables’ from the Table
= menu (refer to paragraph 3.2.1). Pressing the

- Sending data to the Multiplexer only occurs

“Apply” button only saves the information on
the database.

Figure 3-27:  Descriptor Management Section

Common controls for all the descriptors are:

[Refresh] button — Restore the descriptor parameters. Changes made by the
user, which were not applied, will be lost.

[Apply] button — Apply the changes made by the user.

The Advanced Setting view (available by right clicking the descriptor) enables
the user to fine tune where this descriptor will appear in the bit-stream (specific
tables and/or specific sections). Under regular configurations, it is recommended
to leave these settings untouched.
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3.5.6. Proprietary Descriptors

The PSI/SI Generator features the ability to create proprietary descriptors.
Proprietary descriptors are custom descriptors that contain user-defined data.
Creating a proprietary descriptor is a flexible solution for special purpose
descriptors. Each table in the ‘Select Descriptor’ dialog (refer to Figure 3-26) has,
in addition to all the regular descriptors, a proprietary descriptor. Figure 3-28
shows the descriptor management section for the proprietary descriptor. The
descriptor data length must be defined before setting the descriptor data.

P T Proprietamy Dezcrptor

Proprietary Descriptor

Tag ID:-:ED

— Data

Length IUHEE

ool o1 02| 03| 04| 05| 08| 07|
FF |FF FF|FF FF FF FF
02 |FF FF FF FF FF FF FF FF
10|FF FF FF FF FF FF FF FF
18 |FF FF FF FF FF FF FF FF
20|FF FF FF FF FF

& E

]

& Add | m [lg | Apply HEflEShl

|-5] Generator\EFPG.GDE A

Figure 3-28:  Proprietary Descriptors
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Chapter 4.
BOUQUETS MANAGEMENT WINDOW

4.1. GENERAL

The bouquets management window manages all bouquets related parameters.
Figure 4-1 shows the bouquet management window.

Main Detailed
Display Display View
View
D3 PSI/SI Ger erator - Epg.gdb - [Default - Bouguets of Network ID: =10l x|
& Databasef Edit Dataauusels Tools Mndw Help 18 x| Item Name
FEHBR DBEX s Behao b @Sk / Section
*|El G Metwork 1D: 021000 H H
3 g;} ‘EWWHD P 1 Stream ID: 0x1100 / :
L ———r— !"ﬁﬁ .................................................. H
(@ Stream ID: 0¢1 200 : : .
: / i:{& kﬁg S"EETEJIDU Dz?uzm : 0 > Prope rties
. . ouguet 1D: 0, H riginal Netyor 1 : 1
Bouquet Tree <3 @ Sueam Il 12100 o ik o (R : Section
(@ Stieam ID: 0:2200 : :
E i g P —, ?rmmn?m"m?"mww E
i
i | :
/—> Descriptor
o f Maqagement
/ : Section
i + Add | = -| | g Lpply Refresh | i
b Connected ta D:YProgram FileshScopusiPS1-5| Generator\Epg.gdb ‘ - v

\—> Descriptor

List Section

Figure 4-1: Bouquet Management Window
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Each network has a different bouquet management window. To display a network
bouquet management window, do the following steps:

1. Select the network from the PSI/SI Management Tree section in the
PSI1/SI Management window.

2. Press the [Bouquets] command in ‘Additional’ menu.
3. The bouquet management window for the selected network is opened.

The bouquet management menu bar and tool bar are identical to the PSI/SI
Management window menu bar and tool bar. See paragraph 3.2 and paragraph
3.2.12.

The following sections explain the bouquet management window structure and
commands.

4.2. MAIN DISPLAY VIEW

Figure 4-1 shows the PSI/SI Generator bougquets management window.

The bouquets management window is divided into the following two sections:

a. Main Display — The Left side of the window showing the bouquets
hierarchy.

b. Detailed Display — The right side of the window showing the details of
the selected items on the bouquets hierarchy.

The main display view (See Figure 4-1) shows a tree with the bouquets of the
selected network. Every bouquet includes one or more streams.

The operations that can be done on the items of the bouquet tree are identical to
the operations that can be done on the PSI/SI Management Tree in the PSI/SI
Management window. See paragraph 3.4 for detailed explanations on the
available operations of the bouquet items in the bouquet tree.
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4.3. DETAILED DISPLAY VIEW

Figure 4-1 shows the PSI/SI Generator bouquets management window.

The detailed display section of the PSI/SI Management window and the detailed
display view (See Figure 4-1) of the bouquets management window are very
similar. Only the differences between the two sections are described in the
following paragraphs.

The Bouquet Management window ‘detailed display’ section can be found on
paragraph 3.5.

The following paragraphs describe the detailed display view of the bouquets
management window.

NOTE

After changing any configuration, press the “Apply” button to accept the new
configuration or “Refresh” to decline the new configuration and return the old
one. The new configuration will be lost unless the “Apply“ button was pressed.
Sending data to the Multiplexer only occurs when choosing ‘Send Tables’ from
the Data Carousels menu (refer to paragraph 3.2.1). Pressing the “Apply” button
only saves the information on the database.

4.3.1. Item Name Section

The item name section shows the selected item type and ID number. Refer to
Figure 4-1. The name of a Bouquet item is determined by the “Bouquet Name
Descriptor”.

4.3.2. Properties Section

The properties section in the bouquets management window enables to manage
the BAT Table. Refer to Figure 4-1.

4.3.3. Descriptors List Section

The descriptor list section management is similar to the PSI/SI Management
window descriptors list section. See paragraph 3.5.4.
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4.3.4. Descriptor Management Section

The descriptor management section manages the selected descriptor
parameters. Figure 4-1 shows the descriptor management section position in the
bouquets management window. Each descriptor has different parameters.

Common controls for all the descriptors are:

a. [Refresh] button — Restore the descriptor parameters. Changes made by
the user and were not applied will be restored.

b. [Apply] button — Apply the changes made by the user.

The Advanced Setting view (available by right clicking the descriptor) enables
the user to fine tune where this descriptor will appear in the bit-stream (specific
tables and/or specific sections). Under regular configurations, it is recommended
to leave these settings untouched.

NOTE

The Advanced Settings View is for advanced users and for advanced purposes
only.
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Chapter 5.
EVENT MANAGEMENT (EPG) WINDOW

5.1. GENERAL

The event management window manages all events related parameters, and is
used to generate the EPG (Electronic Program Guide) data. Figure 5-3 shows the
event management window.

Each service has a different event management window. To display a service
event management window, do the following steps:

1. Select the service from the PSI/SI Management Tree section in the PSI/SI
Management window.

2. Press the [Events] command in the ‘Additional’ Menu.

3. The events management window for the selected service is opened.

The following section explains the events management window.
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5.2.

EVENT MANAGEMENT MENU BAR

This section describes the Event Management Menu bar. Figure 5-1 displays the
Menu Tree of the Event Management Window. Table 5-1 in paragraph 5.2.1
describes the structure of the menu bar and a brief description on each

command. The following paragraphs explain some of the commands in more

details.
Events Menu
[
[ [ [ I [ [ [ |
Database Edit Carousels Tools Go To View Window Help
| I I I [ [ [ \
Connect New Event Send Profiles Today 1 Day Cascade PSS S;:era“nn
[ [ [ I I I [ [
Disconnect Change Send to All Scheduler Date R Tile Horizontaly About
(5 Days)
| [ [ | I I [
. . Work Week . .
New Delete Receive Log Previous Day (7 Days) Tile Vertically
| I I [ [ [
Backup Cut Rates Next Day Month Minimize All
I I [ [
Restore Copy Event Arrange All
[ [ [
. Present
Exit Paste Event Close
'
[
Move Range
|
Focus on Selected
Figure 5-1: Event Management Window Menu Bar
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5.2.1. Menu Structure

Table 5-1:

Event Management Menu Bar

ITEM

DESCRIPTION

Database Sub Menu

Same as the PSI/SI Management window Database Sub
Menu. Refer to Table 3-1.

Edit=>Cut Cuts an event from the Main Display view.
The Cut command is used for moving events to different
places. The Paste command is used to paste the event in a
different place on the calendar.

Edit>Copy Copies an event from the Main Display view.
The Copy command is used for copying events to different
places. The Paste command is used to paste the event in a
different place on the calendar.

Edit>Paste Pastes an event under a selected place on the calendar.

Edit>>Move Range...

date.

Move Group of Events

howe all events inthe range:

From  |01/01/2000 12:00:00 A= = |

To  |27/08/2003 12:00:00 A= = |

Tothe range which starts at;

W OK

From  |B/01/2002 12:00:00 A= = |

x Cancel |

Move all events between specified dates to a different date.
The 'Move Groups of Events' dialog, shown below, provides
controls for selecting a source date range and a destination
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Table 5-1: Event Management Menu Bar
ITEM DESCRIPTION
Edit>Delete Range... Deletes all events within a selected range. The ‘Select Date

Range’ dialog, shown below, provides controls for selecting a
date range.

Delete Group of Events

Delete all events in the range:

Fram

Tao

| /012000 12:00:00 &M= = |

I 27/08/2003 12:00:00 .-’-‘-.M+l| - I

x Cancel |

W 0K

Data Carousels Sub Menu

Same as the PSI/SI Management window Data Carousel Sub

Menu. Refer to Table 3-1.

Tools Sub Menu Same as the PSI/SI Management window Tools Sub Menu.
Refer to Table 3-1.

GoTo=>Today Changes the calendar date to the current day.

GoTo-=>Date... Opens the select date dialog. The calendar date will change to
the date that was selected in the dialog.

GoTo->Previous... Moves the calendar to the previous screen.

GoTo2>Next... Moves the calendar to the next screen.

GoTo=2>Event>Present Find the event at the current date and time.

GoTo=2>Event>First Find the first event on the calendar.

GoTo=2>Event>Previous Find the previous event from the current date.

GoTo2Event2>Next Find the next event from the current date.
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Table 5-1: Event Management Menu Bar
ITEM DESCRIPTION
GoTo2>Event>Last Find the last event on the calendar.
GoTo=2>Event>Find... Opens the Find Event dialog. Refer to 5.2.2.

Goto=>Event=>Focus on
Selected

Focuses the view on the selected event.

View>0One Day

The calendar displays one day at a time

%3 PSI/SI Generator - EPG.GDE - [De
%5 Database Edt Carousels Tooks

EFE = | BRE OB X

45
P
15
230
45

g
13 A5

Service D: Ox000

W Event ID: 0x0005

:30 |

SCOPUS DOCUMENTS (P/N 100793) (REV. 2.1/ SW V2.1/Decmber 2008)

Page 73



User Manual

C
S1-3050 PSI1/S1 GENERATOR @ngp

Us

Networks

Table 5-1:

Event Management Menu Bar

ITEM

DESCRIPTION

View2>Work Week

The calendar displays five days at a time

43 PSL/SI Generator - Epg.gdb - [Default - Events of Network ID: Dx1000,
& Database Edit DataCarousels Tools GoTo  View Window Help

5 &5

BE(DEX|sBr|[Hmet v|E

Service D 01110 has 1 event(s) B
Mon28 | Tue2d | Wedd | Thudl Fii 01

7 TnEve

9
15

30

45

10
15

a0

45
110
15
Connected ta D:A\Program Files\ScopusiPS1-51 GeneratarsEpg.odb

(KN

View>Week

The calendar displays a whole week at a time

[73 PS1/SI Generator - Epg.gdb - [Default - Events of Network ID: 0x1000,
L Database Edit DotaCaroussls Took GoTo Miew Window Help

REDEX|iBe[mmmk « §

1D DT 110 has 1 eventls) [=]
Thursday, July 31

Selvi

Tuesday, July 29 Friday, &ugust 1
T 19:00 - 20:00 Event 1D: 020001

‘whednesday, July 30 Saturday, August 2

Sunday, August 3

5

Connected ta D:\Program FilestScopusiPS1-51 Generator\Epa.adb
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Table 5-1: Event Management Menu Bar
ITEM DESCRIPTION
View>Month The calendar displays a whole month at a time.

43 PSI/SI Generator - Epg.gdb - [Default - Events of Network 1D: 0x1000|

l&gatahase Edit DataCarousels Tools GoTo Wiew ‘wWindow Help
e s RE DB XX Ee S v §
{ Service 1D: 01110 bas 1 eventis) B

Monday | Tuesday |‘wednesdap| Thursday Friday Sat'Sun

23 30 kil August 1 2

Er19.00 .

3

4 5 [ 7 ) ]

10

n 12 12 14 15 18

17

18 13 20 el 22 23

24

25 26 27 28 29 30

kil
=

Connected to D:\Program FileshS copusiP51-5| Generator\Epg.gdb
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5.2.2. Finding Events

The Find Events dialog searches the calendar for a specific event. The events can
be found by their ID number or by their name property.

The Find Events dialog is opened by choosing GoTo>Events>Find... on the
menu bar of the Event Management screen.

Figure 5-2 shows the two tabs of the Find Event dialog.

[ A] : Find by ID Tab [ B] : Find by Name Tab

/i Find Event x| /i Find Event
Find by 1D | Find by Mame | Find by D Find by Name

Event Name contains the text &7 First

K Previous

T Mext

|
e |

Cu,

I—

¥ Case Sensitive ast

E Cloze | E

Figure 5-2: Find Event Dialog

lw]

lose

To find an event by its ID number, type in the ID edit box on Figure 5-2 [A] the
specific event ID and press the [Find] button.

To find an event by its name, type in the big edit box on Figure 5-2 [B] a text
that the name contains and press one of the following buttons:

a. [First] button — finds the first occurrence of an event that matches the
text.

b. [Previous] button — Finds the previous occurrence of an event that
matches the text.

c. [Next] button - Finds the next occurrence of an event that matches the
text.

d. [Last] button - Finds the last occurrence of an event that matches the
text.

The Event name is the text defined in the “Short event descriptor” under this
event.
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5.3.

5.4.

TooL BAR

The Event Management tool bar is mostly identical to the PSI/SI Management
window tool bar. Refer to the PSI/SI Management window tool bar in paragraph
3.2.12. In addition, the Event Management tool bar includes the commands from
the Go To menu and View menu. Refer to Table 5-1: Event Management
Menu Bar.

MAIN DISPLAY VIEW

Figure 5-3 shows the PSI/SI Generator event management window.

Main Display Detailed
View Display View
3 PS1/SI Generator - Epg.gdt - [Default - Events of Network ID: 01000, Stream ID: 0x o [=] 3]
FL) Datshase Edt DatsCarofels Took GoTo WYiew Window Help _1&] x|
CEs BB DEX sBepan v @S AFAEe T omn MDD
Calendar b Service ID: Nkl 110 bss 6 svents) [=] 2 :
\ - H Ewvent ID: 0x0004 (News)
) - Fridsy, Auigut 1 :
30 PET | -
i i - -
& o [ e Go0E ot e g S Tine [a71,2009 10,1500 P =~ I Fise CA Mods
A5 § EndTime [5/1/2003 10.45.00PM =1+ H
1 Al % Duaton [0 =[Hr [30 =|Min [0 =]3ec
1 45 p
3|7 o W SsEvent ID: 00001 (News) H spry | Retreshd]
S :
Event «—— o Shart Event Descriptor &
45 il Lar\guage;":
i 8 N J St 1000002 fovie) il Edit Choosefrom it 8
H 15 g [engEngish  <F
H 30 \ .
45 .
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Figure 5-3: Event Management Main Display View

The event management window is divided into two sections:
¢ Main Display, on the left side of the window, showing a calendar.

e Detailed Display, on the right side of the window, showing the details
of the selected event on the calendar.

The calendar in the main display screen has several display modes; One-day
display, Five days display, Week display and Month display. See section 5.2 for
more details on the different calendar displays.
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An event is shown inside blue frames with its Event ID number and its name.
Clicking with the right mouse button on the calendar displays a context menu.
The operations in the context menu are related to the selected event. The
following paragraphs describe the context menu commands.

5.4.1. Creating Events

Create an event by doing one of the following:

1. Select New Event from the context menu.

2. Double click on the calendar.

3. Drag the mouse from the starting hour to the ending hour in the one day
display.

A ‘New Event’ dialog is opened (See Figure 5-4). The application suggests a new

unique ID number to the event. The user might want to change the event ID by

editing the ID number in the edit box. Pressing the [OK] button will create a new
event.

e vent T

Enter new Event D
Ranged 0=0000 - 0<FFFF

ID:-:EIEIEI?

Enter Decimal nurber
[0x...] fior Hex nurmber

W OK X Cancel |

Figure 5-4: New Event ID Dialog

5.4.2. Changing Events ID

Change an event by following the steps below:
1. Select an event from the calendar.

2. Choose the Change Event ID command from the context menu.
A dialog which resemble to Figure 5-4 is opened.

3. Change the ID number on the dialog
4. Press the [OK] button.
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5.4.3. Removing Events

To remove an item from the calendar follows the instructions below:
1. Select an event

2. Choose the Delete Event command from the context menu or press the
Del key on the keyboard.

3. A confirmation is required to delete the event. Press the [Yes] button on
the confirmation dialog.

4. The event has been deleted.

5.4.4. Copying / Cutting / Pasting
Events

Events on the calendar can be moved and copied.

To Copy or Cut an event, do the following:

1. Select an event from the calendar

2. Click the right mouse button on the event. A context menu is opened.
3. Choose the ‘Copy’ or the ‘Cut’ commands from the context menu.

To paste the event in a different place, do the following:
1. Select a place on the calendar to copy or move the buffered event.

2. Click the right mouse button on the selected place. A context menu is
opened.

3. Choose the ‘Paste’ command. The buffered event appeared on the
calendar.

5.4.5. Drag and drop support

Moving an event to a different place in the calendar can be done by dragging the
event to the new place. Coping can be done in the same manner with the CTRL
key pressed. Dragging with the Shift key pressed will open a context menu
providing a selection between Moving, Copying and canceling the operation.

5.4.6. Disabling Events

Disabled event parameters will not be generated on the PSI/SI tables but will
remain in the database. The event can be enabled again.
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54.7.

A disabled event is marked with a red icon as seen in Figure 5-5 on Event

0x0007.

Service |D: 0x1110 has 32 event(s)

Sunday, September 21

=l

g Event |D: 0x001E [Sport Event)

Event |D: 0x001F [News)

‘= kvent |D: 020020 (Movie)

3» Disabled
Event

Figure 5-5: Disabled Event in the Calendar

To disable an event, do the following:
1. Select an event from the calendar.

Click the right mouse button on the event. A context menu is opened.

2
3. Choose the ‘Enabled’ command from the context menu.
4. The event state has been toggled between enabled and disabled.

Changing Time Resolution

The time resolution of the calendar is adjustable. The time resolution represents
how much time each raw in the calendar stand for. The options are: 5min, 6min,

10min, 15min, 30 min and 60min.

To change the time resolution, do the following:

1. Right click with the mouse on the time scale on the left side of the

calendar.
A context menu is opened.

2. Select from the context menu the required time resolution.
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5.5. DETAILED DISPLAY VIEW

Figure 5-6 shows the PSI/SI Generator event management window.

The event management window is divided into the following two sections:

e Main Display — The left side of the window showing a calendar.

e Detailed Display — The right side of the window showing the details of the

selected event on the calendar.

Detailed
Display
View

1 P51/5I Generator - Epg.gdb - [Default - Events of Network ID: 0x1000, Stream ID;
£< Datshase Edit DataCaoussls ook GoTo View Window el

FES MR B XL Be w v BSiARSEe o= o8 [[ED

| Service ID: 0x1110 has B everi[s) ~
Fichy, Bugoa 1 e i
£ ar | H
45 rs
6 om [JEEont 10 0005 Spet Evert] | Stat Tane [8/1/72003 101500 oM _ =]
fi I EndTime [6/1/20031045:00PM =1
=0 | Duation [0 =]Hr [30 =min [0 =]sec ]
Z5 - 2
7 o fTiEvent ID: 00001 News) | H _toly | _Rehesh| 3
15 ]
) I - Short Event Descri :
Z | : ] Langunge 1
g #m T Event ID: 040002 [Movie) h J Edt_ Choose from list E
a5 H
g P QT Event ID: 00006 [Short Movie) Character Table |Latn alph: =
A5
30 WSy Event (D: 40003 [Spert Everd) H _I Event Name
a5 H News
10 o0 —
15 WTn Event ID: 00004 [Mews) Event Test
30 H 3
a5 E g H
19 = | S]] [ ] 2 o Refiesh | 3
a8 p 4] H | vl
Connected 1o D:\Prog = 7 T LLFLLT EELEEEIE T Frres e e
Descriptor

List Section

Figure 5-6: Event Management Detailed Display View

Item Name

Section

Properties
Section

Descriptor
Management
Section

The following paragraphs describe the detailed display view of the event

management window.

The PSI/SI Management window also has a detailed display section. The detailed
display section of the PSI/SI Management window and the detailed display
section of the events management window are very similar. Only the differences
between the two sections are described in the following paragraphs.
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NOTE

After changing any configuration, press the “Apply” button to accept the new
configuration or “Refresh” to decline the new configuration and return the old
one. The new configuration will be lost unless the “Apply* button was pressed.
Sending data to the Multiplexer only occurs when choosing ‘Send Tables’ from
the Table menu (refer to paragraph 3.2.1). Pressing the “Apply” button only
saves the information locally.

5.5.1. Item Name Section

The item Name section shows the selected event ID number and name. See
Figure 5-6. The name of an Event item is determined by the “Short Event
Descriptor”. The color of an event item is determined by the “Content
Descriptor”.

5.5.2. Properties Section

The properties section shows the event date, time and duration. Figure 5-6
shows the properties section position in the event management window. Figure
5-7 shows an example of the Properties section. Table 5-2 explains the
properties section.

EIT |

Start Time |5.-"8.-"2003 31500 Ak —:'| "I [~ Free C& Mode
End Time |5£8£2DD3 4:00:00 AM —:'| "I

Duaton [0 =|Hr |45 =|Min [0 =]Sec

Anmly Refrazh

Figure 5-7: Data Section Example

Table 5-2: Data Section Parameters
PARAMETER DESCRIPTION
Start Time — Date Manages the starting date of the selected event
Start Time — Hour Manages the starting time of the selected event
End Time — Date Manages the ending date of the selected event
End Time — Hour Manages the ending time of the selected event
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Table 5-2: Data Section Parameters
PARAMETER DESCRIPTION
Duration — Hr Manages the event duration in hour units
Duration — Min Manages the event duration in minute units
Duration — Sec Manages the event duration in second units
Free CA Mode Turns on and off the Free CA Mode
Apply Saves the changes made to the data section
Refresh Restore the data section parameters. Changes made by the user
and were not applied will be restored.

5.5.3. Descriptors List Section

The description list section management is similar to the descriptors list section
in the PSI/SI Management window. See paragraph 3.5.4.

5.5.4. Descriptor Management Section

The descriptor management section manages the selected descriptor
parameters. Figure 5-6 shows the descriptor management section position in the
event management window. Each descriptor has different parameters.

Common controls for all the descriptors are:

[Refresh] button — Restore the descriptor parameters. Changes made by the
user and were not applied will be restored.

[Apply] button — Apply the changes made by the user.

The Advanced Setting view (available by right clicking the descriptor) enables
the user to fine tune where this descriptor will appear in the bit-stream (specific
tables and/or specific sections). Under regular configurations, it is recommended
to leave these settings untouched.

NOTE

The Advanced Settings View is for advanced users and for advanced purposes
only.

SCOPUS DOCUMENTS (P/N 100793) (REV. 2.1/ SW V2.1/Decmber 2008) Page 83



User Manual f(j scopus
S1-3050 PS1/SI GENERATOR 8 Jog o ot

Chapter 6.
SCHEDULER MANAGEMENT

6.1. GENERAL

The PSI/SI Generator features a task Scheduler. The scheduler performs pre-
defined tasks according to their timing scheme.

This chapter explains the three components that need to be defined to schedule
a task:

¢ Defining the task timing scheme

e Defining the task commands

e Defining the Data Carousels to be updated

6.2. SCHEDULER DIALOG

The Scheduler dialog can be opened from the menu bar: Tools>Scheduler or
from the tool bar. Refer to paragraph 3.2.12 for the Scheduler icon display on
the tool bar.

Task
Parameters

Task List

M sk alue, IS EEEEEEEEENEEEEEEEER

General |Co mands | Timing |

Scheduling Task Name
|New Scheduling Task

After making changes. send tables to these data carousels
Data Carousel Profile
slave Profile2

— Wwhen sending tables
(+ Refiesh only tables that were changed since last send (recommended)

" Fully refresh all tables [takes longer time)
| = o | =0 |
L |
.IIIIII.....IIIIII.....IIIIII....IIIIII.....IIIIII.....—.A—MMI
[ New ¥ Delete P Close

Figure 6-1: Scheduler Dialog

SCOPUS DOCUMENTS (P/N 100793) (REV. 2.1/ SW V2.1/Decmber 2008) Page 84



User Manual (—q SCOPUS
S1-3050 PSI/SI GENERATOR 8 Jag it

The Scheduler dialog contains the following components:
a. Task list — a list of all the tasks the has been set to the scheduler

b. Task parameters — defines the task commands, timing scheme and Data
Carousels to be used. Paragraph 6.3 explains how to setup a task.

[New] button — add a new task to the task list

[Delete] button — deletes a task from the task list

[Apply] button — saves the changes made to the task parameters
[Refresh] button — restores changes that were not applied.

Q@ o o o

[Close] button — closes the Scheduler dialog.

6.3. TASK PARAMETERS

The task parameters are composed out of the three following tabs:

6.3.1. General Tab

The general tab defines the task name and the Data Carousels that sends the
updated tables. The tables are updated automatically by the task, when it
performs at the scheduled time (See Figure 6-1 for the general tab location).

The General Tab contains the following components:
a. Scheduling Task Name

Changes the task name

b. Data Carousel list
List of Data Carousels that sends the new tables from the specified profiles
after the task performs. Note that for each data carousel, a different profile
may be selected.

c. Data Carousel Name Selection

Select or write the Data Carousel name that will be added to the list.
[Add] button — Adds the Data Carousel to the Data Carousels list.

[Del] button — Deletes the selected Data Carousel out of the Data
Carousels list.

f. When Sending Tables — decide whether all the tables are refreshed or
only updated tables are refreshed after the execution of the commands.
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The General Tab has the following operations:

a. Changing the task name:

Rewrite the task name in the Scheduling Task Name

b. Adding a Data Carousel:

1. Select or write the Data Carousel name in the ‘Data Carousel Name

Selection’ combo box.

2. Press the [Add] button.
c. Deleting a Data Carousel:

1. Select a Data Carousel from the Data Carousels list.

2. Press the [Delete] button.

6.3.2. Commands Tab

A task is composed of several commands. The Commands tab defines the set of
commands to be executed. The commands are displayed in the commands list.

The commands are executed one by one from the top of the list to the bottom.
The commands are executed at the time defined by the Timing Tab. Figure 6-2
shows the Commands tab.

# Scheduler

) New I X Delete

Command
List

General Comfiands l Timing |

Commands tf be executed EEEEEEEEEEEEEEEEENENEN

+ 1.fnable ID 2 Change ID
end TCP Message Profile [ Detaut =~
+ 4 Run External File
Node Type | MNetwork-Stream j
Node IDs Level D [

Network 1D 0x1000
Stream ID 0x1100

Change Stieam ID to 0x0000

ENFEEEEEEEEEEEEEER
EEEmEsEEEsE s nnmn®

Apply Refresh
m Close

Figure 6-2: Scheduler Dialog — Commands Tab

Command
Parameters
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Enable ID

Change ID

Send TCP Message
Fun External File
Backup Database
Clear Log

Delete Old Events
Delete Al Events
Expart Data
Impart Data
Expart Log
Change PCR PID

The following commands are available:

Enable ID Command — For details see section 6.3.2.1.
Change ID Command — For details see section 6.3.2.2.

Send TCP Message Command — For details see section 6.3.2.3.
Run External File — For details see section 6.3.2.4.

Backup Database Command — For details see section 6.3.2.5.
Clear Log Command — For details see section 6.3.2.6.

Delete Old Events Command — For details see section 6.3.2.7.
Delete All Events Command — For details see section 6.3.2.8.
Export Data Command — For details see section O.

Import Data Command — For details see section 6.3.2.10.
Exporting Log Command— For details see section 6.3.2.11.
Change PCR PID Command - For details see section 6.3.2.12.

The Commands tab contains the following components:

a. Commands List Defines the commands included in the task.

b. Command Parameters Define the command parameters. The Command
Parameters displays the parameters of the selected command in the
Commands List.

c. [Up] button — Move the selected command higher in the execution order.

d. [Dn] button — Move the selected command lower in the execution order.

[Add] button — Adds a command to the Commands List. A selection box
with the command types appear after pressing the button. The selected
command type is added to the bottom of the Command List.

f. [Del] button — Deletes the selected command from the Commands List.

NOTE

Should one of the commands fail when the task executes, the rest of the

commands in the task are canceled (Except the ‘Send TCP Message’ command

and ‘Run External File’ command).
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6.3.2.1. Enable ID Command

The Enable ID command is used for enabling or disabling a node in the DVB
PS1/SI Management Tree. Figure 6-3 shows the Enable ID command parameters.

# scheduler

Genersl  Commands | Tining |

Commands to be executed

2]
|

1. Ensbls D
2 Change D
3. Send TCF Message Frofle Defaul -
2 Run Externsl Fls

Nede Type [MetworkSteam 7]

Node IDs Level
Network 1D 0x1000
Stream 1D 0x1100

& Add - Del Make this node: * Enabled (" Disabled

Apply Refresh
[ New X Delete P61 Close

Figure 6-3: Scheduler Dialog — Enable ID Command Parameters

The Enable ID command contains the following parameters:
a. Profile - Defines on which profile exists the specified node.

b. Node Type — Defines on which DVB item type should the command be
executed. Available types are:

e Network

e Network — Stream

e Network — Stream — Service

e Network — Stream — Service — PID

e Network — Stream — Service — Event
¢ Network — Bouquet

e Network — Bouquet — Stream

c. Node ID
Defines on which node the command should be executed. The Node ID
displays a table with the selected node type and all of its ancestors. The
exact ID number of the selected node and its ancestors should be defined.
To Change an ID value of a node in the table, do the following:
1. Double click the ID number next to the selected node.
2. Enter the node value.

d. Make this node

This parameter defines the status of the node after execution. The status can
be Enabled or Disabled.
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6.3.2.2. Change ID Command

The Change ID command is used for altering an ID of an item from the DVB
PSI/SI Management Tree. Figure 6-2 shows the Change ID command
parameters.

The Enable ID command contains the following parameters:
a. Profile — Defines on which profile exists the specified node.

b. Node Type — Defines on which DVB item type should the command be
executed. Available types are:

¢ Network

¢ Network — Stream

e Network — Stream — Service

e Network — Stream — Service — PID

e Network — Stream — Service — Event
¢ Network — Bouquet

¢ Network — Bouquet — Stream

c. Node ID — Defines on which node the command should be executed. The
Node ID displays a table with the selected node type and all of its ancestors.
The exact ID number of the selected node and its ancestors should be
defined.

To Change an ID value of a node in the table, do the following:
1. Double click the ID number next to the selected node.
2. Enter the node value.

d. Change [Node Type] ID to — This parameter defines an alternative
value for the above selected node. The [Node Type] above is the type of
the selected node.
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6.3.2.3. Send TCP Message Command

The Send TCP Command is used for sending a message through TCP at a
scheduled time. Figure 6-4 shows the Send TCP Message command parameters.

¥ Scheduler

General  Commands | Timingl
Commands ta be executed
1. Enable ID — 3. Send TCP Message

Change [D
3 Cerd TP Message General | Message |

* 4. Run Extemnal File — Address
Host name or IP
Part
— Take message content from
(* Byte Amay " File

" Text Sting
+ Add = [

Apply Fiefresh |
[ Mew | ¥ Delete | Eglose |

Figure 6-4: Scheduler Dialog — Send TCP Message Command Parameters

The Send TCP Message command contains the following parameters:
a. Address:

1. Host name or IP — The message is sent to the host name or IP
address.

2. Port — The message is sent on a specific port number.

b. Take message content from — The Message tab is edited according to
these parameter settings:

e Byte Array — the message content is an array of bytes.
e Text String — the message content is a text string.

o File — the message content is a file.
c. Message tab — Used for editing the message contents:

e Byte Array — specify the array size and edit the array table.
e Text String — write a text string

e File — specify the full path name of the file. The file is on the server
computer.

SCOPUS DOCUMENTS (P/N 100793) (REV. 2.1/ SW V2.1/Decmber 2008) Page 90



User Manual
S1-3050 PSI1/S1 GENERATOR

S scopus

6.3.2.4. Run External File Command

The Run External File command is used for running a file on the server computer
at a scheduled time. Figure 6-5 shows the Run External File Command

parameters.

General Commands | Timingl

Commands to be executed

2. Change 1D
3. Send TCP Messane
:4. Hur Esternal File

i

* Add = Del

x|

Filename

Parameters

+ 1. Enable ID i~ 4 Run External File

[ Mew | ¥ Delete |

Applyl Hefreshl
Eglose |

Figure 6-5: Scheduler Dialog — Run External File Command Parameters

The Run External File command contains the following parameters:
a. File Name — The full path name of the executable file must be included.

The file is in the server computer.

b. Parameters — Optionally add parameters to the executable file.

NOTE

The executable file will be running in the system security context.
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6.3.2.5. Backup Database Command

The Backup Database command is used for creating a backup file (GBK) at a
scheduled time. Figure 6-6 shows the Backup Database Command parameters.

| # Scheduler - ] x|
Seheduing General - Conmends | T |
~ 1. Backup D atabase

Backup Filename

|

[~ Logon As User

Usemame |

Password |

* Add = Del
Apply | Relfresh
[ New | ¥ Delete | P& Ciose

Figure 6-6: Scheduler Dialog — Backup Database Command Parameters

The Backup Database command contains the following parameters:

a. Backup Filename — The full path name of the file must be included. The
file is saved on the server computer.

b. Logon as User — Enabling password protection when for the database
backup task.

NOTE

The username and password must be identical to the computer's main username
and password.
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6.3.2.6. Clear Log Command

The Clear Log command is used for removing all information from the log file
Figure 6-7 shows the Clear Log Command parameters.

| % scheduler x|
-heduling Task e
Mew Scheduling Task General  Commands I Timing |

Commands to be

f 1. ClearLog

[v Save Log to File Before Cleaning

+ Add = Del

Apply | Refresh

[ Mew | X Delete | Egﬂﬂe

Figure 6-7: Scheduler Dialog — Clear Log Command Parameters

The Clear Log command contains the following parameters:

a. Save Log to File Before Clearing — all existing information is stored
under the../Logs folder before clearing the log file.
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6.3.2.7. Delete Old Events Command

The Delete Old Events command is used for removing all events occurred prior to
the scheduled time. Figure 6-15 shows the Delete Old Events Command

parameters.
fefschedsler x|
Mew adl =
New Scheduling Task Generall Commands | Timing |
glete ents 1. Delete Old Events
q I Profile [Defaur =
Node Type INelwonk-Sheem—Selwcg E'
Node IDs Level [l |
Network 1D 00000
Steam D D000
Service ID 00000
* Add - Del Emf:‘“ [0 = pays [oo:0000 = Hous
Apply | Refiesh

[ New X Delete { % Close I
Figure 6-8: Scheduler Dialog — Delete Old Events Command Parameters

The Delete Old Events command contains the following parameters:

a. Profile - Defines on which profile exists the specified node.
e b. Node Type — Defines on which DVB item type should the command

be executed. Available type Network — Stream — Service

c. Node ID
Defines on which node the command should be executed. The Node ID
displays a table with the selected node type and all of its ancestors. The
exact ID number of the selected node and its ancestors should be defined.
To Change an ID value of a node in the table, do the following:
1. Double click the ID number next to the selected node.
2. Enter the node value.

d. Delete Events Older then

This parameter defines which events are considered old, by setting the Days
and Hours parameters.
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6.3.2.8.

Delete All Events Command

The Delete All Events command is used for removing all of the events from the
data base. Figure 6-15 shows the Delete All Events Command parameters.

| % scheduler

heduling T ask.
heduling Task

[ Mew | X Delete |

x|
General  Commands I Timing |
f [ 1. Delete Al Events

Profile | Dietault ﬂ
Mode Type |Nelwnrk-5tream-53rvice ﬂ
NodeIDs [ Level D [

Network 1D 00000

Stream |0 00000

Service D 00000

+ Add = Del
Apply | Refresh

% Close |

Figure 6-9: Scheduler Dialog — Delete All Events Command Parameters

The Delete All Events command contains the following parameters:

a. Profile - Defines on which profile exists the specified node.

b. Node Type — Defines on which DVB item type should the command be
executed. Available type is Network — Stream — Service.

c. Node ID

Defines on which node the command should be executed. The Node ID
displays a table with the selected node type and all of its ancestors.

The exact ID number of the selected node and its ancestors should be
defined. To Change an ID value of a node in the table, double click the ID
number next to the selected node and then enter the node value.
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6.3.2.9. Export Data Command

The Export Data command is used for creating an Excel or XML format of the
event's data. Figure 6-15 shows the Export Data Command parameters.

General | Commands | Timing |

Commands to be executed
1. Enable ID 3. Expot Data
J Pofle  [Defau =
Node Type ENeiwk-slleun-Se:vm j
NodelDs | Level |'ID
Metwork ID 00001
Stream ID 00001
Service ID 0x0001
Exporter [ j
FieName |
I~ LogonAs User
Usemame f
* Add | - Dal | Password i
Apply | Retresh |

Figure 6-10:  Scheduler Dialog — Export Data Command Parameters

The Export Data command contains the following parameters:
a. Profile - Defines on which profile exists the specified node.

b. Node Type — Defines on which DVB item type should the command be
executed. Available types are; Network, Stream, Service

c. Node ID - Defines on which node the command should be executed. The
Node ID displays a table with the selected node type and all of its
ancestors.

The exact ID number of the selected node and its ancestors should be
defined. To Change an ID value of a node in the table, double click the ID
number next to the selected node and then enter the node value.

d. Exporter - Defines the export file format. The current software version
supports XML only.

e. File Name - Defines a name for the exported file.

f. Logon as User — Enabling password protection to the task.

NOTE

The username and password must be identical to the computer's main username
and password.
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6.3.2.10. Import Data Command

The Import Data command is used for loading Excel or XML events file.

Figure 6-15 shows the Import Data Command parameters.

[ New | X Delete

[ Chi P
+|New Scheduiing Task Gereral Commends | Tining |
e Schedfig Task Commands to be executed
4 | |1 Enableld 3. Import Data
2. Change ID 5
= Profile IDelauIt 3
Node Type INslwork-Stream-Service ZI
NodelDs | Level | Ip 1]
Network. 1D 040001
Stream D 0x0001
Service ID 0x0001
Importer | =l
File Name |
I~ Logon ds Ussr
Username I
& 4dd - el Password I
Apply | Refresh

M Close

Figure 6-11:  Scheduler Dialog — Import Data Command Parameters

The Import Data command contains the following parameters:

a. Profile - Defines on which profile exists the specified node.

b. Node Type — Use the Network — Stream — Service node type.

c. Node ID - Defines on which node the command should be executed. The
Node ID displays a table with the selected node type and all of its

ancestors.

The exact ID number of the selected node and its ancestors should be
defined. To Change an ID value of a node in the table, double click the ID
number next to the selected node and then enter the node value.

c. Importer - Defines the import file format, the current software version
supports Excel and XML formats. Refer to 3.4.9 for more details.

File Name - Defines a name for the imported file.

Logon as User — Enabling login for accessing the import file when

required.
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6.3.2.11. Exporting Log Command

The Export Data command is used for creating a log file in HTML format. The file
is located under the following path:

.\scopus\psi-si generator\log\data_hour.html.

Figure 6-15 shows the Exporting Log Command parameters.

* Scheduler

New Scheduling T ask
New Scheduling Task
New Scheduling Task

General  Commands | Timing |

Commands to be executed

1. Enable ID
2. Change ID
3. Export Data

& Add = Del

4. Export Log

Log Filenamme:

|ScheduledExport

[v Ovenwiite Previous File

Uncheck this to create a new file
for each expart takes more

hard-drive space].

DNew | X peete |

Figure 6-12:

Apval Heflashl
M Close |

Scheduler Dialog — Exporting Log Command Parameters

The Exporting Log command contains the following parameters:

a. Backup Filename — The full path name of the file must be included. The
file is saved on the server computer.

b. Overwrite Previous File — When unchecked, each export is saved to a

new file.
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6.3.2.12. Change PCR PID Command

The Change PCR PID command is used for setting a new value for the PCR PID.

Figure 6-15 shows the Change PCR PID Command parameters.

New Scheduling T ask
New Scheduling Task
New Scheduling Task

1. Enable ID [~ 3. Change PCR PID -

2. Change 1D
Profils |Defaut |
NodeIDs [ Level 1ip ]

Network D 0xD001
Stream 1D 00001
Service ID w0001

& Add - Dal PCR FID IDRUDDU

| Apply | _Refresh
Diew | X peke | % cose |

Figure 6-13:  Scheduler Dialog — Change PCR PID Command Parameters

The Change PCR PID command contains the following parameters:

a. Profile - Defines on which profile exists the specified node.

b. Node Type — Defines on which DVB item type should the command be
executed. Available type is : Network — Stream — Service

c. Node ID

Defines on which node the command should be executed. The Node ID
displays a table with the selected node type and all of its ancestors. The
exact ID number of the selected node and its ancestors should be defined.
To Change an ID value of a node in the table, do the following:

1. Double click the ID number next to the selected node.

2. Enter the node value.

d. PCR PID — Defines the new PID value for the PCR.

This parameter defines which events are considered old, by setting the Days
and Hours parameters.
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6.3.3. Timing Tab

The Timing tab is used to define the time of task execution. The Timing tab
features a sophisticated and flexible task scheduling.

The Timing tab has four recurrence patterns:
a. Never — The task never executes.

Once — The task executes once in a specific time.

c. Daily — The task executes on a daily basis.
d. Weekly — The task executes on a weekly basis.
e. Monthly — The task executes on a monthly basis.

Paragraphs 6.3.3.1 - 6.3.3.5 explains the five recurrence patterns.

6.3.3.1. Never

The ‘Never’ recurrence pattern option is used to keep a task in the task list but to
postpone the task to an unknown date. Figure 6-14 shows the ‘Never’ option in
the scheduler dialog.

o Scheduler x|
New Scheduling Task =
New Scheduling Task General | Commands  Timing ]
Mew Scheduling Task
Select when the scheduling task will be performed:
[~ Dccumence Paltemn
5 Nmr Time of Dccunence J J: 00 _]:'l
" Dnce
 Daily
" ‘Weekly
" Monthly
Next scheduling will occur on No fulure scheduling

Apply Flefreshl
[ New I X Delete [ % Close |

Figure 6-14:  Scheduler Dialog — Timing Tab - Never
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6.3.3.2. Once

The ‘Once’ recurrence pattern option is used for performing a task one specific

time.
#* Scheduler x|
Me eduling Task —
New Scheduling Task General | Commands Timing |
Mew Scheduling Task
Sedect when the scheduling task will be
=0 Pattem
 Never Time of Occunence |14:44:15 =i ofdate |3/3/2008 - |v|
& Dnce
" Daily
 Weekly
" Monthiy
Next scheduling will occur on Mo future scheduling
Apply Refresh |
Dinew | X paete | %] Ciose

Figure 6-15:  Scheduler Dialog — Timing Tab - Once

When the ‘Once’ recurrence patterns is selected, a Date/Time edit box appears
next to it. The Date/Time edit box is used for defining the execution time and

date.
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6.3.3.3. Daily

The Daily recurrence pattern option is used to execute a task every day, or every
several days. Figure 6-16 shows the Daily option in the scheduler dialog.

o Scheduler _N 5]

New Scheduling Task | —
New Scheduling Task General| Commands Timing |

Mew Scheduling Task

Select when the scheduling task will be d
-0 Pattem
i Time of Occurence (144215 = Evey |1 = Dayls)

" Once Start at |3£3£2DDB 3: 'l

COoH | @ overend
€ Endafter [1 = occuencels)

C'M
oy " Endby I 3 vl

Newt schedulingwiliocouron | 4/3/2008 144215

_ spply | Refresh
DiNew | X pekte | ) ciose |

Figure 6-16:  Scheduler Dialog — Timing Tab - Daily

The ‘Daily’ recurrence pattern option has the following setting:

a. Every X Day(s) — the task occur every number of days. The number of
days defined in the Day Count Edit box. When Day Count is one, the task
will occur every day.

b. Start at — The date and time of the first execution of the task. The time
of the first execution will be the time of all other executions.

c. Ending date — the ending date can be set to three options:

e Never end — the task continue executing at the appropriate time.

e End after X occurrences — The task will be executed a constant
number of times and then stop. The number of times is defined in the
‘number of time to run’ edit box.

e End by date — the task stops executing after a specified date and time.
The date and time are defined in the ‘End by’ Date/Time edit box.
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6.3.3.4. Weekly

The ‘Weekly’ recurrence pattern option is used for executing a task on a specific
day or days in the week.
x|

Mew Scheduling Task
Mew Scheduling Task

e

Genetdl Commands  Timing |
Mews Scheduling Task
Select when the scheduling task will be pedi
i~ Dccunence Pattem -
 Never | TimeofOccurence [144215 = Evey [1 = Weekiglon
C Once Statat [33/2008 | [ Sunday -
- . v Monday
Doaily Tuesday
o v & Neverend []'Wednesday
E ekl |~ Endatter [1 = occuencels) |~ g{?;;;day <
Monithiy ] € abyarclaws B
C Endby [z32008 == Sahud
Mext scheduling will occur on A/7/2008 144215
Apply Reﬁeshl

Ditew | X Deete | %) Cose |

Figure 6-17:  Scheduler Dialog — Timing Tab - Weekly

The ‘Weekly’ recurrence pattern option has the following setting:

a. Every X Week(s) — the task will occur every number of weeks. The
number of weeks is defined in the Week Count edit box. When Week
Count is one, the task will occur every Week, on the specified days.

b. Weekdays — the task occurs only on checked days in the weekdays table.
Start at — The date and time of the first execution of the task. The time
of the first execution will be the time of all other executions.

d. Ending date — the ending date can be set to three options:

e Never end — the task continue executing at the appropriate time.

e End after X occurrences — The task will be executed a constant
number of times and then stop. The number of times is defined in the
‘number of time to run’ edit box.

¢ End by date — the task stops executing after a specified date and time.
The date and time are defined in the ‘End by’ Date/Time edit box.
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6.3.3.5. Monthly

The ‘Monthly’ recurrence pattern option is used for executing a task on a specific
day or days in a month.

x|
A veduling Task P
Mewe Scheduling Task Gm‘il Commands  Timing |
Mew Scheduling Task
Select when the scheduling task will be perfi
i Decurence Pattern -
e Time of Occurience [14:4215 = Eveny [1 = Monthislonthe
 Once Statat [3/3/2008 | L st fl
- [ 2nd
~
Daily (+ Mever end L2 iﬁ
.
| - endater [ = occuencels) <2 s
' ﬂ'_"'"‘: — -
Mo~ Endby [ oI HE
Mext scheduling will occur on 4/73/2008 144215
Apply Refresh |

Dew | X Dkt | %] close |

Figure 6-18:  Scheduler Dialog — Timing Tab - Monthly

The ‘monthly’ recurrence pattern option has the following settings:

a. Every X Month(s) — the task will occur every number of months. The
number of months is defined in the Month Count edit box. When Month
Count is one, the task will occur every Month, on the specified days.

b. Month Days — the task occurs only on checked days in the month day
table.

c. Start at — The date of the first execution of the task.
Time of Occurrence - The time of each execution.
Ending date — the ending date can be set to three options:
e Never end — the task continue executing at the appropriate time.

e End after X occurrences — The task will be executed a constant
number of times and then stop. The number of times is defined in the
‘number of time to run’ edit box.

e End by date — the task stops executing after a specified date and time.
The date and time are defined in the ‘End by’ Date/Time edit box.
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Appendix A
RTM 3300/3800 CONFIGURATION

A.l

To configure the PSI/SI Generator correctly, several items need to be checked on
the Multiplexer. Paragraph A.1 describes the checking process of the tables’
status. Paragraph A.2 describes the checking process of the PID numbers. All
operations on those paragraphs are performed on the Multiplexer terminal.

The following paragraphs describe procedures on the CODICO® RTM-3300/3800
DVB Multiplexer. If another Multiplexer is used, please refer to the specific
Multiplexer user manual.

CHECKING TABLES STATUS

To retrieve the table status information, on the Multiplexer main menu press ‘c’
(configuration menu) and then ‘t’ (Automatic Tables configuration menu).

1> : Auto. PAT ehasdis [DISABLED]. toggle
€2 & Auto. PMT ena~dis [DISAELED]. tog9dle
(3} & Auto. HNIT ena~dis [DISABLED]: togdle
4} & Auto. SDT ena~dis [DISAELED]. tog9dle
(3} & Auto. TOT ena~dis [ENAELED]. toggle

Figure A-1: Auto Table Configuration on the Multiplexer Terminal

The terminal shows the status of the table types generated by the Multiplexer
(refer to figure A-1). All enabled table types are generated by the Multiplexer.

To toggle a table state between enabled and disabled:
1. Press the number of the table on the keyboard.

2. When asked if you want to toggle the status, click ‘y’.

3. The status of the table has changed.

\

CAUTION

TABLES CAN BE CREATED BY THE MULTIPLEXER OR WITH THE PS1/SI GENERATOR. EVERY OPTION
HAS ITS ADVANTAGES.

IT IS IMPORTANT TO CHECK THAT NO TABLES WILL BE GENERATED TWICE! REFER TO PARAGRAPH
3.2.12 FOR CONFIGURING TABLE GENERATION ON THE PS1/S1 GENERATOR.
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A.2

NOTE

The Multiplexer clock and the PSI/SI Generator clock must be synchronized once
upon installing the program. The time should be entered as GMT time on the

Multiplexer.

It is recommended that the TDT table be generated by the Multiplexer.

CHECKING PID AND SERVICE

NUMBERS

Follow the instruction below to retrieve the PID and Service numbers:

1. On the Multiplexer
information”).

main menu press

m

(“Multiplexer

2. Press ‘m’ again. (“Multiplexer transp. Stat (‘m’ or ‘n’ or ‘i’)”).

Figure A-2 shows an example of the Multiplexer terminal screen.

transport

InPut number 2

I2: Serv. 3 (OxEOE3 tremarped from
Pid. ZB38CExHEZE LremarFed
Pid. 2831cBxB8Z1> LremarFed
Pid. 2B821cBxE8213 LremarFed
Pid. ZB3ZCExBBZZH LremarFed

==k more i

-3

InPut number 3

I3 Serv. 4 (OxE8884 (remarred from
Pid. 3184cBxbcZB) LremarFed
Pid. 3183¢8xBHcZ1 LremarFed
Pid. 3183¢BxBcZly LremarFed
Pid. 3186cBxECZ2) LremarFed
Pid. 318FCBxBCZZ LremarFed

#——— end of list ——————————= #

1 (BxBEE12>" "

from 4217 CB:187902
from 4194(8x186202
from 419408186202
from 419508186302

1 C@xBEa1sd"*

from 4217CB:187902
from 41940818622
from 4194(8x186202
from 419508186302

from 4197 CB:x186502

FMT
FCR
VIDED
AUDIO

FMT
FCR
VIDED
AUDIO
AUDIO

Figure A-2: Screen Shot of PID List on the Multiplexer Terminal
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A.3

The terminal shows the PID numbers and their categories for every service and
wait until a key is pressed to show the next service.

Update the PID numbers on the Hierarchy Tree on the PSI/SI Generator in order
to keep them synchronized. That way, the tables generated by the PSI/SI
Generator will match the contents of the Multiplexer.

NOTES

e Generally, changing PID numbers should be performed on both the
Multiplexer and the PSI/SI Generator.

e On advanced applications, the PID numbers on the Multiplexer and the
PSI1/S1 Generator may be different.

Configure the Mux to Support ASI Interface

CONFIGURE THE MUX TO SUPPORT
ASI INTERFACE

To configure the Mux to support ASI, Enter the following lines to the
“MCMUX.RMP” file while XX is the Mux input number (0-18):

InputTransparent XX

RemaplnPid XX Ox1FFE O

NOTES

e Refer to the RTM3300/3800 manual, chapter 6 for detailed instruction
about editing the MCMUX.RPM.

¢ The number Ox1FFE on the RemaplInPid line below should be identical to
the stuffing packet PID defined in the PSI/SI Generator. Refer to
paragraph 3.2.12 for more details about ASI configuration and the stuffing
packet PID.
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A.4 CONFIGURE THE MUX TO SUPPORT
UDP INTERFACE

To configure the Mux to support UDP, Enter the following lines to the
“MCMUX.CFG” file while N is the UDP Host Port:do the following:

CtrlUdpOEna ENABLE

CtrlUdpOHostPort N

When using multicast, change the following line while XXX. XXX.XXX. XXX is
the multicast IP address:

CtrludpOHostIP XXX. XXX. XXX. XXX

NOTE

e - Refer to the RTM3300/3800 manual, chapter 6 for detailed instruction
about editing the MCMUX.CFG.

e Although the Mux port number can be any number, it is advised to use
port 8000.

e The IP address defined in the PSI/SI Generator should be identical to the
Mux IP address or to the multicast IP address defined in the
“MCMUX.CFG” file. The port number defined in the PSI/SI Generator
should be identical to the port number defined in the “MCMUX.CFG” file.
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